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Introduction

CloudCompare est un logiciel de gestion et de comparaison de nuages de points 3D (ainsi que de maillages
surfaciques dans une certaine mesure). Son développement a été initié à partir de 2004 dans le cadre d’une thèse
CIFRE financée par EDF R&D et encadrée par l’Ecole Nationale Supérieure des Télécommunications (ENST – Te-
lecom Paris, Laboratoire TSI, équipe TII). Il se poursuit depuis la fin de la thèse (2006). C’est une plateforme de
démonstration des algorithmes étudiés ou développés dans le cadre de la thèse ou ultérieurement. Dans ce sens, il
n’est pas voué à un usage commercial.

Ce logiciel est avant tout pensé pour traiter des nuages de points. Il a été développé en grande partie par Daniel
Giradeau-Montaut avec des participations de :

– Salma Bougacha (stagiaire à EDF R&D en 2004)
– Aurélien Bey (doctorant à EDF R&D depuis début décembre 2008)
– Raphaël Marc (ingénieur chercheur à EDF R&D)

ainsi que des éléments gracieusement fournis par Florent Duguet, alors doctorant à Telecom Paris.

CloudCompare a été essentiellement utilisé pour traiter les intérieurs de centrales relevés à l’aide de scanners
laser par des topographes d’EDF et il a servi ponctuellement pour traiter des relevés de barrages ou de tours aéro-
réfrigérantes..

Ce logiciel permet entre autres choses :
– de calculer les distances locales entre deux nuages de points denses (figure de gauche ci-dessous) ;
– de filtrer le bruit de mesure du scanner laser pour mettre en évidence les vraies différences (figure du milieu) ;
– de segmenter les différences pour faire apparaître des objets ou morceaux d’objets correspondant à des diffé-

rences entre les deux jeux de données comparés (figure de droite).

L’originalité de CloudCompare tient à plusieurs aspects :
– les structures de données utilisées : un "octree" permettant de charger en mémoire et d’afficher des nuages

de points volumineux (plusieurs millions de points en 3D) et de calculer rapidement (c’est-à-dire en quelques
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secondes) les écarts entre deux jeux de données volumineux, ou encore un "Kd-tree" permettant de recaler
rapidement deux nuages de points entre eux.

– deux types de calculs de distance entre nuages de points (calculs qui n’existaient pas auparavant) : un calcul
précis basé sur une distance de type Hausdorff (distance au plus proche voisin) ; et un calcul très rapide mais
moins précis basé sur une distance de Chanfrein ;

– le filtrage du bruit de mesure ;
– la prise en compte des différences d’échantillonnage entre les jeux de données comparés ;
– la prise en compte de la visibilité du scanner pour chaque jeu de données ;
– le rendu PCV (Portion de Ciel Visible) sur nuage de points via la carte graphique, qui permet une forte amélio-

ration de la lisibilité de ce type de données à l’écran.
Bien que CloudCompare soit capable de gérer des maillages triangulaires ou des ensembles de polylignes 3D,

ces entités restent avant tout pour CloudCompare des nuages de points (les sommets) munis d’une structure par-
ticulière, à côté de nombreuses autres structures (octree, kd-tree, couleurs, normales, champs scalaires, photos
calibrées, etc.). L’utilisateur est donc invité à toujours garder cette particularité à l’esprit lorsqu’il utilise CloudCom-
pare, et il devra en particulier toujours faire attention au rôle de chaque entité 3D dans les traitements proposés par
ce logiciel.

0.1 Licence

Le logiciel CloudCompare est constitué des deux composants logiciels suivants :
– La librairie CClib ;
– Le programme qCC exécutable qui utilise la librairie CClib.

Installer et utiliser ces deux composants du logiciel CloudCompare signifie que vous acceptez les termes et les
conditions de leurs licences respectives. La version 2 datant de mars 2007 et les versions antérieures de ces deux
composants logiciels sont la propriété d’EDF et de TELECOM ParisTech.

Licence de la librairie CClib :
La librairie CClib est diffusée sous la licence GNU LGPL (GNU Lesser General Public Licence) telle qu’elle a été
publiée par la FSF (Free Software Foundation) ici : http ://www.gnu.org/licenses/gpl.html

Licence du programme exécutable qCC :
Le programme qCC est diffusé sous la licence GNU GPL (GNU General Public Licence) tel qu’elle a été publiée par
la FSF (Free Software Foundation) ici : http ://www.gnu.org/licenses/lgpl.html

EDF et TELECOM ParisTech accordent à l’utilisateur les droits d’installer et d’utiliser le logiciel CloudCompare après
l’avoir téléchargé depuis le site http ://rd.edf.com. Le logiciel CloudCompare est fourni en l’état, sans aucune garantie
explicite ou implicite. Les auteurs déclinent toute responsabilité pour tout dommage direct ou indirect. L’utilisateur
assume tous les risques et responsabilités quant à la qualité du logiciel CloudCompare et de son utilisation.

0.2 Installation du binaire

CloudCompare fonctionne sous les systèmes d’exploitation Windows 2000 et Windows XP. Il n’a pas encore été
porté sous Linux.
La distribution des binaires de CloudCompare ne comporte pas de programme d’installation. Il suffit de décompres-
ser l’archive .zip contenant l’exécutable et les DLLs. Nous listons ci-dessous les fichiers (.exe ou .dll) que vous devez
trouver après décompression de l’archive :

Pour la version 2.0 de CloudCompare (IHM basée sur Fltk/Flu) :
– CloudCompare.exe (exécutable principal)
– CC_Dll.dll (librairie CClib)
– cv100.dll (DLL de la librairie openCV utilisée pour le traitement de photos)
– cxcore100.dll (DLL de la librairie openCV utilisée pour le traitement de photos)
– DevIL.dll (DLL de la Developer’s Image Library permettant de charger de nombreux formats d’images)
– glew32.dll (DLL de la librairie OpenGL Extension Wrangler Library)

http://www.gnu.org/licenses/gpl.html
http://www.gnu.org/licenses/lgpl.html
http://rd.edf.com
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– highgui100.dll (DLL de la librairie openCV utilisée pour le traitement de photos)
– ILU.dll (DLL de la Developer’s Image Library permettant de charger de nombreux formats d’images)
– ILUT.dll (DLL de la Developer’s Image Library permettant de charger de nombreux formats d’images)
– libguide40.dll (permet de faire le lien avec la DLL Math Kernel Library d’Intel R©)
– xerces-c_2_7.dll (librairie C++ de parsing de fichiers XML)

Remarque : il est possible que l’exécution de CloudCompare 2.0 réclame la présence des DLL msvcp71.dll et
msvcr71.dll. Ces DLLs font partie de la Microsoft C++ Runtime Library (téléchargeable sur le site de Microsoft).

Pour la version 2.1 de CloudCompare (IHM basée sur Qt 4) :
– qCC.exe (exécutable principal)
– CC_Dll.dll (librairie CClib)
– FreeImage.dll (librairie du projet open source FreeImage permettant de lire et d’écrire les formats d’image les

plus courants)
– mingwm10.dll (DLL du compilateur minGW permettant le multi-threading)
– QtCore4.dll (DLL permettant d’utiliser Qt)
– QtGui4.dll (DLL permettant d’utiliser Qt)
– QtOpenGL4.dll (DLL permettant d’utiliser Qt)

Et de manière optionnelle, sous le répertoire plugins :
– qHPRPlugin.dll (plugin de la fonction « Hidden Point Removal »)
– qPCVPlugin.dll (plugin de la fonction de rendu « Portion de Ciel Visible »)
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Chapitre 1

Interface

1.1 Fenêtre principale

La fenêtre principale de CloudCompare est constituée des éléments suivants :

– 1 : barre de menus de l’application. Cette barre permet d’accéder à l’ensemble des fonctions disponibles dans
CloudCompare. Il se peut toutefois qu’en fonction des objets sélectionnés, certains des menus ne soient pas
accessibles. Par exemple, les menus « Edit » et « Tools » restent inactif tant qu’aucun objet n’est sélectionné
(visible sur la capture ci-dessus).

– 2 et 3 : barres d’outils. Les différentes icônes visibles sur ces barres permettent d’accéder rapidement à un
certain nombre de fonctions de CloudCompare. Ces fonctions sont toutefois accessibles en passant par les
menus appropriés, via les menus (1). Les barres (2) proposent des fonctions liées au traitement des objets,
tandis que la barre (3) permet seulement de modifier les paramètres de visualisation.

– 4 : arbre de navigation. Cette zone permet de visualiser sous forme d’arborescence l’ensemble des objets
chargés ou crées par l’application. Il est notamment possible de sélectionner des objets en cliquant dessus
dans cette zone. Par la suite, on appellera liste l’ensemble des éléments regroupés sous la même arborescence
(sur la capture ci-dessus, on peut voir deux listes).



6 CHAPITRE 1. INTERFACE

– 5 : fenêtre de propriétés de l’objet courant. Si un unique objet est sélectionné, cette vue permet de visualiser et
modifier certaines des propriétés de cet objet.

– 6 et 7 : contextes graphiques. Ces vues permettent de visualiser « en trois dimensions » les objets disponibles
en mémoire. CloudCompare offre la possibilité de visualiser les objets dans un contexte graphique commun,
ou dans plusieurs contextes distincts (sur la capture ci-dessus, 2 contextes graphiques).

– 8 : console. Cette zone contient l’historique des informations liées à l’exécution de CloudCompare (typiquement
des informations supplémentaires non estentielles délivrées par les algorithmes). Elle peut être affichée ou
masqué via la commande Console du menu Display.

– 9 : barre de statut. Les messages d’aide rapide relatifs à certaines fonctionnalités de CloudCompare y sont
affichés. Lorsque vous positionnez le curseur de la souris sur un bouton ou une commande dans les menus, le
message d’aide apparaît instantanément dans cette barre. Toutefois, toutes les commandes ne disposent pas
forcément d’un tel message.

L’ensemble des entités chargées dans CloudCompare peuvent donc être accessible via l’arbre de navigation text-
colorred(4) et éventuellement dans le(s) contexte(s) graphique(s) textcolorred6,7.

Il est possible de déplacer et repositionner les différentes barres d’outils. Pour ce faire, il suffit de saisir la partie
manipulable située à l’extrémité de la barre en cliquant dessus, puis de le déplacer en maintenant le bouton gauche
de la souris enfoncé :

La barre ainsi déplacée peut être laissée flottante, ou insérée à une nouvelle position, auquel cas les éléments
voisins se réagencent automatiquement. Les barres d’outils peuvent aussi être affichées ou masquées, via le sous-
menu Display/Toolbar : les éléments cochés correspondent aux barres visibles, les autres étant masquées.

De même, la fenêtre de navigation ainsi que la fenêtre de propriétés peuvent être déplacées en saisissant leur
barre de titre en les faisant « glisser » jusqu’à la position voulue.

Dans la suite de ce document, nous allons détailler les fonctionnalités de base offertes par CloudCompare, à sa-
voir les manipulations liées à la visualisation des entités disponibles dans l’application. L’utilisateur pourra se référer à
la partie suivante du document (Chapitre 2) pour obtenir des informations détaillées sur les fonctionnalités avancées.

1.2 Objets disponibles

1.2.1 Arbre de navigation

Comme nous l’avons vu précédemment, CloudCompare affiche l’ensemble des objets disponibles (chargés ou
crées par l’application) dans la fenêtre de navigation, qui se trouve par défaut dans la partie gauche de la fenêtre
principale. On peut y trouver les éléments suivants :
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Un groupe d’entités. Cet élément peut correspondre par exemple à un fichier ouvert, et regroupe alors tous les
nuages chargés à partir de ce fichier. Il sera dans ce cas nommé avec le chemin du fichier source.
Un nuage de points.

Un maillage simple.
Un ensemble de maillages, géré alors comme un maillage standard (on peut aussi parfois retrouver les
sommets des maillages sous forme de nuages de points derrière ce type d’élément).
Une structure ??.

Un objet ??.

Une photo (potentiellement calibrée).

Remarque : les groupes d’entités ne sont pas des entités manipulable à proprement parler. Typiquement, elles ne
peuvent pas être utilisées comme entrées pour les fonctions de CloudCompare) : elles ne servent que de « classeur
».

De manière classique, l’arborescence peut être développée ou repliée en cliquant respectivement sur les boutons
et situés à gauche des jonctions de l’arbre (ce qui permet d’afficher ou de cacher les sous-entités qui y sont

rattachées).

La case située à gauche d’un élément permet d’activer ou de désactiver (respectivement lorsqu’elle est cochée
ou non-cochée) l’entité correspondante. La notion de désactivation est plus forte qu’un simple affichage/masquage
de l’entité (il existe une propriété générique à toute entitée affichable dans un contexte graphique permettant de gérer
ceci - voir plus loin). Les entités inactives (ainsi que toutes les sous-entitées ratachées) ne sont pas affichées, mais
de plus elles ne sont pas non plus concernées par les opérations interactives comme la segmentation graphique, et
plus généralement, elles ne peuvent pas non plus être selectionnées (et ne peuvent donc pas être utilisées comme
entrée des fonctions de CloudCompare).

1.2.2 Sélectionner des objets

Pour sélectionner une entité, deux possibilités s’offrent à l’utilisateur : cliquer avec le bouton gauche de la souris
soit sur l’entité dans l’arbre de navigation, soit sur sa représentation dans le contexte graphique. Dans les deux cas,
l’objet sélectionné apparaît en surligné dans l’arbre de navigation, et entouré d’une boîte englobante dans le contexte
graphique où figure l’objet. Lorsqu’un élément est sélectionné, les informations qui s’y rapportent apparaissent dans
la fenêtre de propriétés. Certains des éléments présents dans cette fenêtre peuvent être modifiés, les autres étant
présentés à titre indicatif.

Il est possible de sélectionner plusieurs entités, en ayant recours aux commandes classiques de multi-sélection
sous Windows : sélection des objets un par un en cliquant dessus (dans l’arbre de navigation ou dans un contexte
graphique) tout en maintenant la touche CTRL enfoncée. Pour dé-sélectionner un objet tout en conservant ceux
qui ont déjà été choisis, cliquez une nouvelle fois sur cette entité en maintenant toujours la touche CTRL enfoncée.
En maintenant la touche MAJ enfoncée, puis en sélectionnant deux objets (dans l’arbre de navigation uniquement),
l’ensemble des entités visibles entre les deux objets choisis seront sélectionnés. Une dernière possibilité consiste à
survoler dans l’arbre de navigation les objets à sélectionner en maintenant le bouton gauche de la souris enfoncé.

La plupart des commandes de CloudCompare ne s’appliquent qu’aux entités sélectionnées. Ces commandes ne
sont d’ailleurs actives que lorsque l’utilisateur a sélectionné le nombre d’objets approprié et les bons types d’objets.
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1.3 Affichage des objets

1.3.1 Contexte graphique

Les contextes graphiques (ou « vues 3D » - voir figure 1.1) sont les sous-fenêtres dans lesquelles sont visualisés
les entités. Elles sont globalement organisées de la manière suivante :

– 1 : Échelle. Fournit une référence pour l’estimation des distances. L’échelle est indiquée dans l’unité de distance
dans laquelle les coordonnées sont exprimées (CloudCompare n’utilise pas d’unités de distances explicites).

– 2 : Trièdre d’orientation. Les trois axes affichés représentent les axes X (rouge), Y (vert) et Z (bleu). Ce trièdre
indique l’orientation du point de vue courant.

– 3 : Boîte englobante. Il s’agit du parallélépipède rectangle le plus petit qui contienne l’intégralité du ou des
objets sélectionnés. Les axes de la boîte sont alignés sur les axes X, Y et Z, notamment visibles sur le trièdre
d’orientation (2).

– 4 : Nom du champ scalaire actif (reportez vous à la section 1.4.2.2 pour plus d’informations quant aux champs
scalaires).

– 5 : Informations temporaires concernant l’affichage. Il peut s’agir de la dimension courante du contexte (en
pixels - après un redimensionnement de la fenêtre), du type de projection utilisé, etc.

– 6 : Rampe de couleurs. Permet de repérer les valeurs associées aux couleurs lorsqu’un champ scalaire est
actif et affiché.

FIGURE 1.1 – Eléments standards d’une vue 3D (contexte)
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Seuls l’échelle et le trièdre d’orientation sont visibles en permanence. Les autres informations dépendent de l’état
courant de l’application.

1.3.2 Environnement multi contextes

La majorité des entités chargées en mémoire (et visibles au niveau de l’arbre de navigation), sont affichables
dans des contextes graphiques (vues 3D). Un nombre quelconque de ces fenêtres de visualisation peut être créé, et
les entités peuvent être chacune assignées individuellement à un contexte différent.

Pour créer un nouveau contexte graphique, cliquez sur la commande New dans le menu 3D views, ou appuyez
simultanément sur les touches CTRL et F3. Une nouvelle fenêtre apparaît alors (par défaut elle remplira toute la zone
réservée aux contextes graphiques).

Pour séparer l’espace d’affichage entre les différents contextes ouverts, différents moyens existent :
– Le partitionnement : chaque fenêtre occupe une portion de l’espace disponible, les fenêtres ne se chevauchent

pas. Pour partitionner l’affichage, cliquez sur Tile dans le menu 3D views.
– L’affichage en cascade : chaque fenêtre occupe la même portion d’espace prédéfinie, les fenêtres se che-

vauchent toutes. Pour disposer les contextes en cascade, cliquez sur Cascade dans le menu 3D views.

– Redimensionner chaque contexte « à la main », en s’aidant notamment des boutons (minimiser le contexte)

et (réduire le contexte), disponibles en haut à droite de chaque fenêtre.

Il est aussi possible de naviguer entre les différents contextes ouverts, via les commandes Next et Previous du
menu 3D views, ou en accédant directement au contexte voulu en cliquant sur son nom dans le menu 3D views.

Pour fermer un contexte, cliquez sur Close dans le menu 3D views après avoir sélectionné la fenêtre à supprimer

ou directement sur le bouton de la fenêtre.

Enfin, pour changer le contexte dans lequel un objet apparaît, sélectionnez l’objet, puis dans la fenêtre de pro-
priétés, choisissez le contexte de destination dans la liste déroulante Current Display.

Il est possible de n’afficher l’objet dans aucun contexte en choisissant None comme contexte de destination.

1.3.3 Interactivité

Vous pouvez changer le point de vue 3D dans un contexte en utilisant la souris :

– L - click gauche : [SELECTION] cliquez sur un objet dans un contexte graphique pour le sélectionner.
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FIGURE 1.2 – Commandes via la souris (L : [SELECTION/ROTATION], M : [ZOOM], R : [PAN])

– L - enfoncé : [ROTATION] maintenez le bouton gauche de la souris enfoncé et déplacez la souris pour effectuer
une rotation du point de vue autour du centre courant du système d’affichage (cf. sections 2.4.4 et 2.4.5).

– M - roulement : [ZOOM] faites rouler la molette du milieu vers l’avant (vers « le haut ») pour effectuer un zoom
positif dans le contexte (rapprochement). Inversement, faites rouler la molette vers de le bas (« l’arrière ») pour
effectuer un zoom négatif (éloignement).

– R - enfoncé : [PAN] maintenez le bouton droit de la souris enfoncé et déplacez la souris pour effectuer une
translation du point de vue dans le plan écran.

Par défaut, le centre de rotation du point de vue est positionné sur le centre de la scène, et la visualisation se fait
selon une projection orthographique (sans perspective). Lors du changement de point de vue (rotation du vecteur
visée), les gros nuages de points sont temporairement sous échantillonnés de manière à permettre le rendu interactif
des mouvements.

Les contextes graphiques sont indépendants les uns des autres, et les changements de point de vue dans un
contexte n’ont à priori aucune répercussion sur les autres. Toutefois, il est possible de synchroniser les mouvements
de caméra pour qu’ils soient appliqués à tous les contextes en même temps. Pour ce faire il suffit de cocher l’op-
tion Camera link sous la fenêtre de navigation. Pour rétablir le fonctionnement normal des contextes graphiques,
décochez cette même case.

1.3.4 Options d’affichage

Un certain nombre de commandes permettent à l’utilisateur de modifier les propriétés d’affichage. Certaines sont
notamment accessibles via la barre d’outils Viewing tools :
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Changer les paramètres d’éclairage de la scène (détaillé ci-dessous).

Changer la taille d’affichage des points (détaillé ci-dessous).

Zoomer et recentrer la caméra sur toute la scène dans le contexte graphique courant.

Zoomer et recentrer la caméra sur les objets sélectionnés. Pas d’effet si aucun objet n’est sélectionné.
Utilisez les 6 boutons pour basculer entre les différents points de vue prédéfinis (dans l’ordre où les boutons
apparaissent : haut, bas, avant, arrière, gauche, droite). Les points de vue sont définis par rapport au trièdre
d’orientation.

Le bouton donne accès à la fenêtre de paramétrage de l’éclairage et des matériaux de CloudCompare. L’utili-
sateur peut y modifier le comportement de la source lumineuse, la couleur par défaut des nuages de points incolores,
la couleur par défaut des maillages incolores, en distinguant au passage les faces "avant" des faces "arrière", et les
couleurs de divers éléments composant les contextes graphiques. Cette fonctionnalité est décrite plus en détail dans
la section 2.4.7.

Le bouton vous permet d’accéder au paramétrage de la taille des points, via une boîte de dialogue visible en
surimpression en haut à gauche dans l’espace d’affichage des contextes graphiques :

Pour modifier la taille d’affichage des points , il suffit de faire glisser le curseur : plus le curseur est à droite, plus
les points seront gros. L’afficahge est mis à jour de manière interactive. Cliquer sur OK pour valider et fermer la boîte
de dialogue.

D’autres fonctionnalités sont accessibles via le menu Display :
– Full screen : basculer la fenêtre principal en affichage plein écran. Pour rétablir l’affichage normal, appuyer sur

la touche F11.
– Refresh : actualiser l’affichage.
– Test frame rate : lancer le test d’estimation du taux de rafraîchissement (exprimé en Frame Per Second) du

contexte courant. En théorie, plus il y a de triangles ou de points à afficher, plus le taux de rafraîchissement
devrait être faible. Il est admis qu’en deçà d’une vingtaine d’images par seconde, l’humain perçoit l’affichage
comme étant saccadé (au delà de 24 f.p.s, l’affichage est perçu comme étant fluide). Si le taux de rafraîchis-
sement est trop faible, il est alors conseillé de limiter le nombre d’objets à traiter en n’affichant que les objets
d’intérêt.

– Toggle viewer based perspective : passer en projection perspective et positionner le centre de rotation du point
de vue sur la caméra elle-même. Pour rétablir le centre de rotation dans sa position d’origine (au centre de la
scène) cliquez une nouvelle fois sur cette commande.

– Toggle centered perspective : passer en projection perspective et positionner le centre de rotation du point de
vue sur le centre de la scène observée. Pour rétablir la projection par défaut (parallèle orthographique), cliquez
une nouvelle fois sur cette commande.

– Light & Materials/Toggle sun light : activer ou désactiver la lumière globale.
– Light & Materials/Toggle custom light : activer ou désactiver la lumière personnalisée (celle-ci est déplaçable

en maintenant la touche CTRL enfoncée tout en faisant un pan avec la souris à l’écran).

Remarque : les effets d’ombrage ne sont visibles que si au moins une source lumineuse est active.

Il est aussi possible de changer la couleur d’affichage individuelle des nuages de points. La couleur n’est visible
que lorsqu’aucun champ scalaire n’est affiché (cf. section 1.4.2.2). Pour changer la couleur d’un nuage, sélectionnez
le puis ouvrez le sous-menu Edit/Colors.

– La commande Set unique permet de choisir une couleur commune appliquée à tous les points du nuage (Cf.
section 2.2.1).



12 CHAPITRE 1. INTERFACE

– La commande Colorize permet de mélanger une nouvelle couleur à la couleur courante du nuage de points
(Cf. section 2.2.2). Cette opération consiste à multiplier les couleurs composante par composante, les couleurs
étant exprimées sous la forme d’un vecteur [Rouge, Vert, Bleu]. Par exemple, si le nuage est jaune en tout point
([1, 1, 0]), et que l’on applique colorize avec une couleur violette ([1, 0, 1]), on obtiendra un nuage de couleur
rouge ([1 ∗ 1, 1 ∗ 0, 0 ∗ 1] = [1, 0, 0]).

– La commande Height ramp permet d’appliquer un dégradé de couleurs au nuage selon un des 3 axes princi-
paux du repère (Cf. section 2.2.3).

– La commande Clear permet enfin de supprimer la couleur courante du nuage. Après application de cette
commande, les points du nuage seront affichés avec la couleur par défaut.

1.4 Propriétés des objets

1.4.1 Propriétés communes

Certains champs visibles dans la fenêtre de propriétés des objets sont communs à toutes les entités manipulées
par CloudCompare. On les retrouve dans la section CCObject :

– Name : nom associé à l’objet. Il peut être modifié en double cliquant sur le nom (partie droite du champ) ou
encore en appuyant sur la touche F2.

– Entites : ce champ indique le nombre de sous-entités rattachées à l’objet courant. Dans la capture ci-dessus par
exemple, l’objet sélectionné est un groupe de maillages regroupant 759 sous-maillages (et nuages de points).
Les sous-entités peuvent être accédées indépendamment en développant l’objet courant dans l’arborescence
de la fenêtre de navigation (cf. section 1.2.1).

– Visible : si cette case est cochée et si l’objet n’est pas désactivé dans l’arbre de navigation (cf. section 1.2.1),
alors l’objet est affiché dans le contexte graphique indiqué par Current display. Dans le cas contraire, il reste
caché et seule sa boite englobante peut apparaître (lorsque il est sélectionné).

– Current display : permet de choisir le contexte graphique dans lequel l’objet est affiché (cf. section 1.3.2).

La suite de cette documentation présente les propriétés spécifiques à chaque type d’entité. Il existe en effet des
champs (voire même des sections entières) qui ne sont disponibles qu’après certains traitements ou pour un type
d’objet donné.

1.4.2 Nuages de points

1.4.2.1 Propriétés communes

Deux champs sont communs à tous les nuages de points :
– Colors : disponible dans la section CCObject, permet d’activer (si la case est cochée) ou de désactiver (sinon)

l’affichage de la couleur paramétrée pour le nuage de points (cf. section 1.3.4). Attention : ne pas confondre
les couleurs des points avec les champs scalaires, qui ne doivent pas être assimilés à des couleurs mais bien
à des valeurs scalaires (réelles) associées à chaque point (la couleur n’étant dans ce cas qu’un moyen de
visualisation - Cf. section 1.4.2.2). Il est donc possible que les points restent "colorés" à l’écran bien que la
"couleur" du nuage soit désactivée.

– Points : consultable dans la section Cloud, indique le nombre de points composant le nuage.

Les nuages de points disposant de normales (vecteurs normaux) possèdent un champ Normals permettant de
prendre en compte ou non ces vecteurs lors de l’affichage du nuage (via un effet d’ombrage semi-réaliste).
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1.4.2.2 Champs scalaires (Scalar fields)

Certains traitements effectués sur les nuages de points permettent d’associer à chaque point une valeur réelle
(un scalaire). L’ensemble de ces scalaires est stocké dans une structure appelée Champ Scalaire (Scalar field dans
l’interface) et rattaché au nuage de points.

Il est possible de rattacher plusieurs champs scalaires à un même nuage, mais un seul peut être actif à un instant
donné. Le nombre de champs scalaires associés à un nuage peut être consulté via la valeur de l’entrée Number
dans la section Scalar field(s).

Pour choisir le champ scalaire actif, il faut sélectionner dans la fenêtre de propriétés du nuage un champ dans
la liste déroulante Current de la section Scalar field(s). Notons au passage que les champs scalaires sont nommés
automatiquement par CloudCompare, en fonction des traitements qui ont permis de les générer. Un seul champ
peut-être affiché à la fois.

L’utilisateur pourra alors visualiser sous forme de couleurs les valeurs associées aux points, pour le champ sca-
laire actif. Pour ce faire, il suffit de cocher la case Scalar field de la section CC Object. Chaque point du nuage sera
alors coloré en fonction de sa valeur, et suivant l’échelle de couleur choisie. Pour revenir à l’affichage ordinaire du
nuage de points, décochez cette même case.

Différentes échelles de couleurs sont disponibles. Chacune correspond à un dégradé de couleurs, la première
couleur étant associée à la valeur minimale du champ scalaire, la dernière couleur à la valeur maximale, et le reste
des couleurs étant associées aux valeur intermédiaires de manière linéaire (dans le cadre de la configuration par
défaut des paramètres de visualisation des champs scalaires).

valeur minimale valeur maximale
Bleu à rouge :

Niveaux de gris :

Rouge à jaune :

Rouge à blanc :

Pour changer l’échelle de couleurs de visualisation des champs scalaires, sélectionnez l’élément voulu dans la
liste déroulante Color ramp de la section Scalar field(s) :
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Vous pouvez afficher la rampe de couleurs dans le contexte graphique où figure le nuage de points (cf. figure de
la section 1.3.1), en cochant la case Display scale dans la section SF scale. Pour masquer la rampe, décochez cette
même case :

Enfin, CloudCompare offre à l’utilisateur la possibilité de paramétrer plus finement la visualisation du champs
scalaire courant, en manipulant les quatre potentiomètres disponibles dans la section SF scale (ou en modifiant les
champs textes associés qui se trouvent à leur droite). Dans le doute, pour savoir à quoi correspond un potentiomètre,
il suffit de positionner le curseur de la souris dessus et de patienter quelques secondes le temps qu’une description
apparaisse (vous pouvez aussi lire le texte d’aide visible immédiatement dans la barre de statut en bas de la fenêtre
principale). Le rôle de chaque potentiomètre est définit de la manière suivante :

– 1 : Valeur minimale affichée (Min displayed value). Toutes les valeurs scalaires inférieures à (1) sont ignorées
(NaN : Not a Number) lors de l’affichage.

– 2 : Valeur minimale de saturation (Min saturation value). Tous les points ayant une valeur scalaire associée
inférieure à (2) sont affichés dans la couleur « la plus faible » (ici en bleu).

– 3 : Valeur maximale de saturation (Max saturation value). Tous les points ayant une valeur scalaire associée
supérieure à (3) sont affichés dans la couleur « la plus forte » (ici en rouge).

– 4 : Valeur maximale affichée (Max displayed value). Toutes les valeurs scalaires supérieures à (4) sont ignorées
lors de l’affichage.

L’affichage des valeurs ignorées est piloté par la propriété Nan in grey : si elle est cochée, les points associés à
des valeurs scalaires ignorées sont affichés en gris. Sinon ces points ne sont pas affichés.

Les quatre valeurs présentées ci-avant permettent donc de définir deux plages :
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– les valeurs affichables, pour lesquelles les points sont effectivement affichés en couleurs. Le comportement en
dehors de cette plage dépend de Nan in grey.

– la plage de saturation, en dehors de laquelle la dynamique de couleur est désactivée. La borne inférieure de
cet intervalle est associée à la première couleur de l’échelle, la borne supérieure à la dernière couleur, le reste
des couleurs étant réparti linéairement sur les valeurs scalaires comprises dans l’intervalle.

CloudCompare vérifie en temps réel les valeurs saisies : on ne peut pas avoir (1) > (4) ni (2) > (3). Toute mo-
dification valide d’une de ces valeurs est immédiatement répercutée sur l’affichage courant des points de manière
interactive.

1.4.3 Maillages / groupes de maillages

Ces deux types d’entités partagent les mêmes propriétés :
– Normals : disponible dans la section CCObject, ce champ permet d’activer (si la case est cochée) les normales

lors de l’affichage de l’objet. Les normales permettent d’obtenir un rendu visuel semi-réaliste des objets, dans
la mesure où ce sont elles qui servent au calcul d’éclairement des facettes. Si cette option est désactivée, le
calcul d’éclairement ne peut être effectué et la surface de l’objet est affichée dans une couleur uniforme (effet
« silhouette », perte de l’impression de profondeur).

– Faces : consultable dans la section Mesh, indique le nombre de facettes composant le maillage. Dans le cas
d’un groupe de maillages, ce nombre correspond au nombres total de facettes des sous-maillages qui sont
rattachés à ce groupe.

– Wireframe : disponible dans la section Mesh, permet d’activer (si la case est cochée) le rendu en « fil de fer »
de l’objet.

Le rendu "fil de fer" consiste à n’afficher que les bords des facettes composant le maillage (sous forme de segments).
Il s’agit d’un rendu sans masquage des arêtes cachées : toutes les arêtes sont affichées, même celles qui ne sont
pas visibles du point de vue de la caméra car cachées par des faces. Il ne s’agit donc pas d’un rendu de type "hidden
lines" (voir figure 1.3).

1.4.4 Octree

1.4.5 Présentation

L’octree est une structure destinée à accélérer les traitements sur des données spatiales. Il s’agit d’un découpage
récursif et hiérarchique de l’espace (en cubes décomposant l’espace). CloudCompare construit une telle structure
par dessus les nuages de points dans de très nombreux cas pour accélerer ses traitements. C’est un type d’octree
particulier qui est particulièrement rapide à construire.

D’un point de vue général, l’octree est défini par niveaux de subdivison :
– Le premier niveau (niveau 0) est le plus petit cube englobant entièrement le nuage de points.
– Au niveau N+1, l’octree est construit en subdivisant chacun des cubes du niveau N en 8 sous-cubes de même

taille (en pratique on ne se souvient que des sous-cubes contenant au moins un point du nuage).

Il est important que l’utilisateur comprenne bien le principe de cette structure, puisqu’elle occupe une place cen-
trale dans CloudCompare.

Plus le niveau d’octree est élevé :
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FIGURE 1.3 – Exemple de rendu "fil de fer" d’un maillage

– plus le nombre de cubes à traiter est élevé : potentiellement 8N = 23N cubes au niveau N . Pour idée, bien
que cela soit très peu probable, on peut donc avoir jusqu’à 221 = 2 097 152 cubes au niveau 7 d’un octree. Au
niveau 10, on a 230 cubes, soit un peu plus d’un milliard ! (là encore, cela est peu probable, d’autant plus qu’il
faudrait au moins autant de points). En pratique, beaucoup de cubes sont vides et ne sont donc pas conservés
en mémoire, d’où une structure généralement relativement compacte. Enfin, CloudCompare utilise un codage
spécial de l’octree qui fait que sa taille est toujours proportionnelle au nombre de points du nuage, et ne dépend
pas de la répartition spatiale de celui-ci. C’est aussi pour cette raison que le niveau maximal d’un octree est
fixé à 10 dans CloudCompare, pour que le codage par point ne soit pas trop important.

– plus les cubes sont petits : si aN est la taille d’une arête du cube au niveau N (donc a0 est la taille du cube
initial), aN = a0

2N . En effet, par construction, on divise par deux la taille des cubes selon chaque dimension
lorsqu’on descend d’un niveau. Par exemple, les cellules de l’octree au niveau 5 d’un octree sont 32 fois plus
petites que la cellule englobant le nuage (au niveau 0).

– plus le nombre de points par cube est faible : intuitivement, les cubes étant plus petits, ils contiennent moins de
points.

– plus l’enveloppe de l’octree (la surface globale formée par l’ensemble des surfaces externes des cubes) est
proche du nuage de points.

Les 3 captures d’écran de la figure 1.4 donnent un aperçu de la répartition et de la taille des cellules d’octree à
differents niveaux de subdivision.

Beaucoup de traitements sur les nuages de points ont recours à un octree. Lorsque c’est possible, le niveau d’oc-
tree optimal pour les calculs à effectuer est déterminé de manière automatique et transparente par le programme.
Toutefois, certains calculs font appel à une estimation de l’utilisateur quant au niveau à utiliser. Dans ces situations,
il s’agit généralement pour l’utilisateur de trouver un niveau qui aboutisse au meilleur compromis entre le nombre de
cubes à traiter (pas trop grand, donc un niveau pas trop élevé) et le nombre moyen de points par cube (le plus petit
possible, donc un niveau pas trop faible). Trouver le bon niveau peut donc nécessiter une certaine expérience.

1.4.6 Affichage

L’octree est indissociable du nuage de points auquel il est rattaché. Il s’agit d’une structure abstraite, disponible
dans l’interface de CloudCompare uniquement à titre visuel. L’affichage proposé par CloudCompare ne permet de
visualiser qu’un niveau à la fois. Vous pouvez changer le niveau d’affichage de l’octree en incrémentant/décrémentant
le champ Display level de la section Octree.
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FIGURE 1.4 – Cellules à différents niveaux d’octree : niveau 1 (gauche), 3 (milieu) et 6 (droite).

Les niveaux qui peuvent être affichés vont de 1 à 10. Le niveau 0 ne peut être sélectionné (il n’est dailleurs en
pratique jamais utilisé, pas même pour les calculs, puisque l’octree au niveau 0 correspond ni plus ni moins au nuage
dans son intérgralité).

Il se peut que l’affichage ralentisse considérablement au delà d’un certain niveau de subdivision (en fonction des
capacités de l’ordinateur sur lequel le programme s’exécute), à cause du nombre conséquent d’éléments à afficher.
Dans ce cas, préférez donc des niveaux d’affichage raisonnables autant que possible.

L’octree peut être visualisé sous différentes formes :
– Fil de fer (Wire) : seules les arrêtes des cubes sont représentées.
– Points : chaque cube est représenté par le centre de gravité des points qui y sont inclus.
– Surfacique (Plain cubes) : la surface des cubes est pleinement affichée.

Pour changer l’affichage de l’octree, sélectionnez un mode dans la liste déroulante Display type de la section octree.

1.5 Modification interactive des entités

1.5.1 Segmentation manuelle

Cet outil est accesible via l’icône .

Il est possible de "découper" manuellement à l’écran la ou les entités sélectionnées. Celui-ci permet de définir
graphiquement (voir figure 1.5), par des clics successifs un contour, puis de choisir si l’ont veut "garder" les points à
l’intérieur ou à l’extérieur de ce contour. Le processus est répétable à volonté, et les points rejetés sont cachés au
fur et à mesure. Si l’utilisateur valide sa "découpe", le nuage courant est remplacé par les points correspondant aux
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points sélectionnés et un nouveau nuage avec les points restants est créé à côté.

Cela marche aussi avec les maillages, mais les triangles à la frontière ne sont pas découpés à proprement parler
(on garde les triangles totalement inclus dans la frontière, et les autres appartiennent à l’extérieur de la sélection).

FIGURE 1.5 – Outil de segmentation manuelle

L’outil est materialisé par une barre d’icônes qui apparaît en haut à droite de l’écran :
– la première icône permet de mettre en pause la segmentation (ce qui permet de faire tourner l’entité 3D se-

lectionnée par exemple entre deux "découpes"). Attention, si la segmentation est mise en pause, le contour
actuellement dessiné disparaît. Si une découpe est effectuée (voir les deux points suivants), la segmentation
est automatiquement mise en pause. Si l’outil n’est pas en pause, l’utilisateur peut définir le contour par clics
gauches successifs à l’écran. Le premier ne fait rien, puis les suivants rajoutent un segment à chaque fois
reliant le précédent clic au dernier. Un clic droit permet de fermer le contour (nécessaire pour effectuer une
sélection). Enfin, tout clic gauche intervenant après une fermeture du contour réinitialise le contour.

– l’icône suivante correspond à une selection des points à l’intérieur du contour. Les points à l’extérieur sont
cachés et la segmentation est mise en pause (le contour doit être fermé).

– l’icône suivante correspond à une selection des points à l’extérieur du contour. Les points à l’intérieur sont
cachés et la segmentation est mise en pause (le contour doit être fermé).

– l’icône suivante correspond à une réinitialisation complète de la sélection (tous les points redeviennent visibles).
– l’avant dernière icône permet de valider la découpe et de quitter.
– la dernière icône permet d’annuler la découpe et de quitter.

1.5.2 Rotation/translation manuelle

Cet outil est accessible via l’icône .

Il permet d’appliquer une rotation et/ou une translation manuelle aux entités sélectionnées. Lorsqu’il est activé, 3
icônes apparaissent en haut à droite :
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– La première permet de réinitialiser la transformation appliquées aux entités sélectionnées.
– La seconde permet de valider la transformation et de quitter.
– La dernière permet d’annuler la transformation et de quitter.

La transformation se fait interactivement avec la souris, en utilisant les mêmes conventions que pour la transfor-
mation du point de vue (Cf. section 1.3.3). Le bouton gauche permet de tourner les entités (par rapport au centre de
gravité des boites englobantes des unités sélectionnées) et le bouton droit permet de translater les entités dans le
plan de l’écran.

1.6 Barres de progression

Certaines commandes sous CloudCompare nécessitent un temps de traitement relativement long, pouvant aller
de quelques secondes à quelques minutes selon la capacité de l’ordinateur sur lequel l’application s’exécute, ainsi
que le paramétrage de la fonction et la complexité inhérente au traitement effectué. La barre de progression est
une fenêtre apparaissant durant les calculs non immédiats, donnant un aperçu de l’état d’avancement du traitement
(lorsque la barre est remplie, le calcul est terminé).

Parmi les commandes affichant une barre de progression, certaines permettent d’arrêter le calcul en cours d’exé-
cution, via le bouton Cancel (l’arrêt du processus n’est pas forcément immédiat, l’ordinateur ne prenant en compte
la commande que lorsqu’il est suffisamment "disponible" pour pouvoir le faire). Lorsque ce bouton n’est pas visible,
le traitement ne peut être interrompu avant la fin du calcul.

1.7 Barres d’outils

Vous trouverez ci dessous la liste des boutons disponibles dans les diverses barres d’outils de CloudCompare.

Bouton Commande Description
Barre d’outils Main tools

Open cf. section 2.1.1

Save cf. section 2.1.2

Clone cf. section 2.2.24

Fuse cf. section 2.2.25

Delete Supprimer les objets sélectionnés

Register cf. section 2.3.4

Align cf. section2.3.3
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Bouton Commande Description

Subsample cf. section 2.2.28

Sample points cf. section 2.2.10

Cloud/Cloud distance cf. section 2.3.5

Cloud/Mesh distance cf. section 2.3.6

Statistical test cf. section 2.3.9

Label connected components cf. section 2.3.10

Segment cf. section 1.5.1

Translate/Rotate cf. section 1.5.2

Barre d’outils Scalar Field Tools

Show histogramm Afficher l’histogramme du champ scalaire courant.

Compute statistical parameters cf. section 2.3.8

Filter by value cf. section 2.2.20

Gradient cf. section 2.2.18

Gaussian filter cf. section 2.2.19

Delete current scalar field Supprimer le champ scalaire actif du nuage sélectionné.

Difference cf. section 2.2.21

Barre d’outils Miscellaneous Tools

Peut contenir des éléments différents que ceux listés ici (en fonction des plungins disponibles) .

Hidden Points Removal cf. section 2.5.2

Global Enlighting cf. section 2.5.1

Barre d’outils Viewing Tools

Cette barre d’outils est présentée en section 1.3.4.

Les barres d’outils sont affichées ou masquées selon qu’elles sont cochées ou non dans le sous-menu Dis-
play/Toolbars. Pour changer l’état d’un barre d’outils (visible ou non), cliquez sur son nom dans Display/Toolbars.

1.8 Raccourcis clavier

Le tableau suivant liste les raccourcis clavier proposés dans CloudCompare :

Touche(s) Commande Fonctionnalité Remarque
F1 Help afficher le document d’aide de CloudCompare
F2 Rename renommer l’entité sélectionnée
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Touche(s) Commande Fonctionnalité Remarque
F3 Toggle centered

perspective
positionner le centre de rotation du point de vue sur
le centre de la scène, activer/désactiver la
projection perspective

cf. section 1.3.4

CTRL + F3 New 3D View ouvrir un nouveau contexte graphique
F4 Toggle viewer

based
perspective

positionner le centre de rotation du point de vue sur
la caméra / rétablir le point de vue par défaut

cf. section 1.3.4

CTRL + F4 Close 3D View fermer le contexte graphique courant (avant
d’appliquer ce raccourci, il faut sélectionner un des
objets de la fenêtre qu’on veut fermer dans le
browser d’objets à gauche)

F5 Refresh rafraîchir l’affichage
F6 Toogle sun light active / désactive la source lumineuse globale cf. section 1.3.4
F7 Toggle custom

light
active / désactive la source lumineuse secondaire cf. section 1.3.4

F8 Set unique color appliquer une couleur aux objets sélectionnés cf. section 1.3.4
F11 Full screen afficher la fenêtre principale en plein écran / revenir

à l’affichage classique.
F12 Test frame rate calculer le taux de rafraîchissement du contexte

graphique courant
cf section 1.3.4

CTRL + O Open ouvrir un objet à partir d’un fichier cf. section 2.1.1
CTRL + D Delete list supprimer de l’application les listes sélectionnées
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Chapitre 2

Fonctions

Dans cette section sont détaillées les fonctions accessibles via le menu principal. Elles sont classées par sous-
menu.

2.1 Menu ’File’

2.1.1 Open (file)

FIGURE 2.1 – Interface de sélection d’un fichier

Permet de charger une entité 3D en mémoire via une interface standard (figure 2.1).

Remarques :
– Raccourci clavier : CTRL+O
– Si le chargement est réussi, l’entité sera automatiquement affichée dans le contexte actif
– Dérouler le menu Look in (en haut) permet d’accéder à divers chemins usuels, ainsi qu’aux chemins récemment

utilisés
– Dérouler le menu Files of type (en bas) permet de choisir un filtre pour l’affichage des fichiers du répertoire

courant (si le filtre est « *.* », le format du fichier sélectionné est détecté automatiquement par CloudCompare
en fonction de son extension)
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2.1.2 Save (file)

Permet de sauvegarder dans un fichier l’entité sélectionnée (voire plusieurs entités à la fois si le format de fichier
choisi le permet). Le fichier est désigné via une interface standard (figure 2.1).

Remarques :
– Dérouler le menu Look in permet d’accéder à divers chemins usuels, ainsi qu’aux chemins récemment visités
– Dérouler le menu Files of type (en bas) permet de filtrer les fichiers du répertoire courant affichés et de désigner

le format de sauvegarde
– Une extension sera automatiquement rajoutée au nom du fichier en fonction du format de sauvegarde choisi

par l’utilisateur (si ce dernier ne spécifie pas d’extension).

2.2 Menu ’Edit’

2.2.1 Colors > Set Unique

FIGURE 2.2 – Interface de sélection d’une couleur unique

Permet de définir une couleur qui sera appliquée à tous les points de l’entité 3D sélectionnée. Le choix est manuel,
et se fait via une interface classique proposant divers modes de sélection (figure 2.2) :

– soit en choisissant une couleur basique (en haut à gauche), ou une couleur précédemment sauvegardée (cus-
tom - en bas à gauche)

– soit en cliquant sur la zone colorée (en haut à droite) et en faisant varier l’intensité avec l’ascenseur en dégradé
(à droite)

– soit en rentrant manuellement les paramètres dans les trois champs HSV ou RGB (en bas à droite)
Raccourci clavier : F8

2.2.2 Colors > Colorize

Même interface que la fonction "Set Unique" (2.2.1). Cette fonction permet de modifier les couleurs actuelles des
points (par multiplication des composantes de la couleur actuelle par celles de la couleur sélectionnée). Si l’entité n’a
pas de couleur, alors la fonction est équivalente à "Set Unique".
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FIGURE 2.3 – Interface de sélection d’une rampe de couleur

FIGURE 2.4 – Rampe de couleur par défaut

FIGURE 2.5 – Exemple d’un dégradé vert à rouge appliqué selon Z

2.2.3 Colors > Height Ramp

L’utilisateur à le choix entre appliquer une rampe par défaut (figure 2.4) ou alors une rampe dont il définit les
deux couleurs extrêmes (figure 2.3). Il faut dans pour cela désactiver la case Use default ramp. Les deux couleurs
extrêmes du dégradé peuvent alors être définies en cliquant sur les champs First color et Second color (qui font
apparaître des interfaces de sélection de couleur unique, comme pour la méthode Set Unique par exemple - Cf.
section 2.2.1).

Dans tous les cas, l’utilisateur peut enfin choisir selon quelle des 3 directions principales X, Y ou Z (se référer au
trièdre de visualisation qui apparaît en bas à droite de l’écran) le dégradé sera appliqué.
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2.2.4 Normals > Compute

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.

Cette fonction permet de calculer les normales (non signées) d’un nuage de points qui en serait dépourvu, et ce
via différentes méthodes. Pour obtenir un champ de normales signées, il faut utiliser la fonction Resolve direction (Cf.
section 2.2.6).

Les deux méthodes acutellement disponibles sont :
– LS : approche par ajustement local de plan avec la technique des moindres carrés (méthode rapide mais

bruitée)
– HF : approche par interpolation des points par une fonction de hauteur quadratique (plus robuste mais moins

rapide)

2.2.5 Normals > Invert

Inverse les normales (les normales correspondant à des vecteurs tridimensionnels unitaires, on remplace cha-
cune par le vecteur opposé).

Note : cela permet généralement de corriger le problème de sens (direct ou indirect) des triangles de maillages,
dont la norme n’est pas partagée par tous les logiciels de traitement ou de génération de maillages ...

2.2.6 Normals > Resolve direction

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.

Algorithme de résolution du sens correct des vecteurs normaux associés à un nuage de points. La résolution se
fait de proche en proche, par propagation d’un ou plusieurs fronts sur le nuage (algorithme de Fast Marching).

La propagation se fait sur une grille 3D (ici l’octree) et il faut donc choisir un niveau d’octree auquel appliquer
l’algorithme. Le choix du bon paramètre n’est malheureusement pas évident, car un niveau faible va entraîner des
cellules de taille importante, d’où une propagation aisée et rapide mais une mauvaise prise en compte des circon-
volutions locales, alors qu’un niveau élevé va entraîner l’inverse. De plus, plus la propagation est difficile - i.e. par
morceaux - plus le risque de voir des zones proches ayant des sens opposés est forte. Il faut donc essayer l’algo-
rithme à différents niveaux d’octree, en commençant typiquement à 5 ou 6, puis augmenter le niveau jusqu’à trouver
un niveau satisfaisant. L’algorithme est très rapide, et il peut être exécuté à volonté (il ne modifie pas les normales,
uniquement leur sens).

Note : la résolution est au sens près, il peut donc être nécessaire d’utiliser la fonction Invert (Cf. section 2.2.5)
pour obtenir le résultat final recherché.

2.2.7 Octree > Compute

Cette fonction calcule une structure octree (subdivision récursive de l’espace) au dessus du nuage de points
sélectionné (ou des sommets dans le cas d’un maillage). Une fois l’octree calculé avec succès, il est affiché automa-
tiquement par dessus l’entité sélectionnée (Cf. section 1.4.6).

Note : le niveau maximal de subdivision d’un octree est 10 dans cette version de CloudCompare.

2.2.8 Octree > Resample

Fonction de ré-échantillonnage (grossier) d’un nuage. L’utilisateur spécifie un nombre approximatif de points (via
l’interface 2.6), et CloudCompare détermine alors le niveau d’octree ayant un nombre de cellules le plus proche de
cette valeur. Le nuage ré-échantillonné est alors formé en remplaçant chaque cellule par un point représentatif (ac-
tuellement, le centre de gravité des points présents à l’intérieur de la cellule).
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FIGURE 2.6 – Interface de sélection du nombre de points pour le ré-échantillonnage

Remarque : cette méthode est différente de la méthode Subsample (Cf. section 2.2.28) car elle crée des points,
contrairement à Subsample qui sélectionne des points existants dans le nuage source.

2.2.9 Mesh > Compute

Cette fonction permet de calculer un maillage 2D 1
2 par dessus un nuage de point (via la triangulation de Delaunay).

Puisque la méthode produit un maillage 2D 1
2 à partir d’un nuage 3D, il faut projeter celui-ci sur un plan avant de

calculer la triangulation. Ainsi deux choix s’offrent à l’utilisateur (la fonction est déclinée en deux versions) :
– Axis aligned plane : par défaut, CloudCompare estime que les altitudes sont portées par l’axe principal Z et les

points sont donc projetés sur le plan (XY)
– Best LS plane : approche plus générique, qui projette les points sur le plan interpolant le mieux le nuage au

sens des moindres carrés (elle est adaptée aux nuages assez plats dont les altitudes ne sont pas forcément
portées par Z).

2.2.10 Mesh > Sample Points

Cette fonction échantillonne de manière aléatoire des points sur une surface décrite par un maillage (voir fi-
gure 2.7).

FIGURE 2.7 – Illustration du principe de l’échantillonnage de points sur un maillage

Un nouveau nuage de points est créé. L’utilisateur à le choix via l’interface 2.8 de spécifier :
– le nombre total de points désiré.
– ou une densité par unité de surface. Attention, la surface est exprimée dans la même unité (au carré) que celle

utilisée pour les coordonnées des sommets du maillage. Pour connaître la surface totale du maillage , vous
pouvez appeler la fonction Mesh > Measure surface - section 2.2.11).
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FIGURE 2.8 – Interface de paramètrage pour l’échantillonnage de points sur un maillage

2.2.11 Mesh > Measure Surface

Calcule la surface du maillage.

Cette surface est exprimée dans la même unité (au carré) que celle utilisée pour les coordonnées des sommets
du maillage.

2.2.12 Mesh > Scalar Field > Smooth

FIGURE 2.9 – Exemple de résultats obtenus avec les options smooth et enhance d’un champ scalaire porté par les
sommets d’un maillage

Applique un lissage du champ scalaire porté par les sommets d’un maillage, en utilisant la topologie de celui-ci.
La valeur scalaire au niveau d’un sommet est remplacée par une moyenne pondérée des valeurs scalaires portées
par ses voisins.

Remarque : cette fonction est beaucoup plus rapide que la fonction Gaussian filter (section 2.2.19) pour un résultat
approchant, mais elle nécessite d’une part un maillage associé au nuage de points (ces derniers correspondant aux
sommets du maillage) et elle ne permet pas de régler la taille du noyau de lissage.

2.2.13 Mesh > Scalar Field > Enhance

Applique un réhaussage du contraste sur un champ scalaire porté par les sommets d’un maillage, en utilisant la
topologie de celui-ci. La valeur scalaire au niveau d’un sommet est modifiée pour augmenter le contraste par rapport
aux valeurs scalaires portées par ses voisins.

Cette fonction est l’inverse de Mesh > Scalar Field > Smooth (section 2.2.12).

2.2.14 Sensor > Ground-Based Lidar > Show depth buffer

Cette fonction n’est pas encore intégrée dans la version 2.1 de CloudCompare.

Affiche la carte de profondeur associée à un capteur.
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2.2.15 Sensor > Ground-Based Lidar > Export depth buffer

Cette fonction permet d’exporter la carte de profondeur associée à un capteur sous la forme d’un fichier texte.

Elle s’applique au nuage qui "contient" le capteur sélectionné (il faut donc au préalable sélectionner une entité
capteur ).

L’utilisateur est invité à spécifier un nom de fichier dans lequel seront sauvegardées toutes les informations rela-
tives à la carte de profondeur (voir section A.1.3.2).

2.2.16 Sensor > Create

Cette fonction permet ce créer un capteur (une représentation virtuelle d’un scanner laser) associé à un nuage.

En général, l’utilisateur voudra créer a posteriori le scanner qui a permis l’acquisition du nuage de points sélec-
tionné. Cela permet en particulier d’appliquer des filtrages intelligents lors du calcul de distance entre deux nuages
de points (Cf. section 2.3.5).

FIGURE 2.10 – Interface de paramètrage pour la création d’un capteur

Lors de la création d’un capteur, de nombreux paramètres sont réglables (via différents onglets de l’interface 2.10) :
– rotation order : ordre des rotations du scanner (moteur, miroir). Nous utilisons ici les angles θ et φ suivant

les conventions habituelles des coordonnées sphériques : θ représente l’angle (le débattement) horizontal du
capteur, φ représente l’angle vertical du capteur. Il existe deux choix actuellement : θ puis φ (type GS de
Trimble) ou φ puis θ (type Soisic de Trimble).

– Position (center)/(X,Y,Z) : position X,Y,Z du centre optique du scanner (exprimée dans le référentiel du nuage
de point)

– Position (center)/Sensor base : écart entre l’émetteur laser et le récepteur (utile pour un capteur à triangulation
comme le Soisic typiquement).

– Orientation : repère du capteur exprimé par rapport au repère du nuage (trois vecteurs). Par défaut, la matrice
formée par ces trois vecteurs est laisée à l’identité, ce qui revient à avoir une orientation droite selon les 3 axes
du repère courant.

– Angular steps/dPhi : pas angulaires (en degrés) du capteur selon φ.
– Angular steps/dTheta : pas angulaires (en degrés) du capteur selon θ.
– Other/Uncertainty : l’incertitude sur la mesure laser, en pourcentage (déduite automatiquement lors de la pro-

jection).
– Other/Max. range : la portée maximale (déduite automatiquement lors de la projection).

Une fois les paramètres rentrés, CloudCompare créé un objet capteur qu’il associe au nuage. Celui-ci contient
entre autre une carte de profondeur du nuage (obtenue en projetant les points dans le référentiel angulaire du
capteur - et équivalente à un Z-buffer ) qui permet d’une part des filtrages intelligents lors du calcul de distances
comme évoqué plus haut, mais qui peut-être aussi visualisée (section 2.2.14) ou exportée (section 2.2.15). Enfin
l’objet capteur est affichable en situation sous la forme d’un petit capteur 3D schématique (voir figure 2.11).
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FIGURE 2.11 – Objet capteur affiché in situ

2.2.17 Sensor > Modify

Permet de modifier les paramètres d’un capteur.

La même boîte de dialogue que celle montrée sur la figure 2.10 pour la création d’un capteur est affichée pour
la modification mais ici, les valeurs des paramètres du capteur correspondent à ceux qui ont été saisis lors de la
création (et non aux paramètres par défaut).

2.2.18 Scalar Fields > Gradient

FIGURE 2.12 – Interface de paramètre pour le calcul des normales

Cette fonction permet de calculer les normes du gradient du champ scalaire actif.

Lorsqu’elle est appellée, CloudCompare demande à l’utilisateur de préciser si le champ scalaire correspond à
une distance euclidienne (telles que les distances calculées entre deux nuages ou entre un nuage et un maillage). Si
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oui, l’algorithme filtrera les valeurs aberrantes, qui sont alors facilement détectables (en effet, dans ce cas le gradient
en valeur absolue ne peut pas être supérieur à 1 - Cf. thèse de D. Girardeau-Montaut).

Remarques :
– L’algorithme crée un nouveau type de champ scalaire (Gradient norms).
– Comme pour du traitement d’image 2D classique, le gradient permet notamment de mettre en valeur les zones

de fortes variations du champ scalaire (on met ainsi en évidence les bords des zones de changement par
exemple - voir figure 2.12).

– Comme pour du traitement d’image 2D classique, il est souvent nécessaire d’appliquer un filtre gaussien aux
données avant et/ou après un calcul du gradient (Cf. section 2.2.19).

– Le fait que la valeur de la norme du gradient ne soit jamais supérieure à 1 est vrai en réalité pour tout champ
scalaire dont les valeurs varient proportionnellement à la distance entre les points (c’est donc le cas d’un champ
de distances).

2.2.19 Scalar Fields > Gaussian Filter

Application d’un filtre gaussien au champ scalaire actif.

Il faut simplement définir le noyau sigma du filtre gaussien. Pour régler ce paramètre simplement, on peut se
servir de l’octree, en prenant comme noyau la taille d’une cellule au niveau 8 pour un filtrage doux, 7 pour un filtrage
relativement fort, etc. (la taille d’une cellule est affichée au niveau de la console lorsqu’on affiche un rendu du nuage
via l’octree - Cf. section 1.4.6).

Remarques :
– A partir de sigma, on peut déduire très simplement le rayon de la sphère en 3D délimitant le voisinage qui sera

considéré autour de chaque point. On calcule en effet pour chaque point la moyenne des valeurs scalaires de
ses voisins, moyenne pondérée par la distance selon une loi gaussienne. Etant donné que 3σ correspond à un
écrasement du poids de 99,9%, il n’est pas utile de considérer les points plus éloignés.

– Plus le noyau est grand, plus le calcul est lent.
– Cette fonction est très utile pour lisser le résultat d’un calcul du gradient (section 2.2.18) mais aussi d’un calcul

de Portion de Ciel Visible (section 2.5.1) par exemple.

2.2.20 Scalar Fields > Filter by Value

FIGURE 2.13 – Interface de paramètrage pour le filtrage des points par valeur du champ scalaire

Cette fonction permet de segmenter un nuage en définissant un intervalle de valeurs scalaires (figure 2.13). Un
nouveau nuage sera créé avec tous les points dont les valeurs scalaires (champ scalaire actif) sont inclues dans cet
intervalle.

2.2.21 Scalar Fields > Difference

Cette fonction n’est pas encore intégrée dans la version 2.1 de CloudCompare.

Outil de calcul de différences point à point entre deux champs scalaires portés par des nuages identiques. Son
principe est de calculer pour deux nuages identiques (spatialement) portant chacun un champ scalaire, la différence
des valeurs portées par les points homologues.
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Cet algorithme nécessite la sélection de deux nuages et uniquement deux. CloudCompare demandera à l’utilisa-
teur de préciser le rôle des nuages, via l’interface générique de choix des rôles - voir section 2.3.4). En effet, le calcul
est signé, et il faut donc décider d’un ordre pour la soustraction des valeurs (champdiff = champA − champB). C’est
d’ailleurs le premier nuage (le nuage A) qui recevra un nouveau champ scalaire correspondant à la différence.

Remarques :
– Le terme identique est en fait un peu fort. Il suffit que tous les points du nuage A se trouvent dans le nuage B.

Ainsi, il suffit que le nuage A soit une sous-partie du nuage B.
– L’algorithme crée un nouveau type de champ scalaire (Diff ) qui est signé.

2.2.22 Scalar Fields > Multiply

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.

Cette fonction multiplie les champs scalaires des deux nuages de points sélectionnés. Les deux nuages doivent
avoir le même nombre de points. Le champ scalaire de la première liste est mis à jour avec le résultat de la multipli-
cation par l’algorithme.

Remarque : pour appeler cette fonction, il faut sélectionner deux nuages munis de champs scalaires, et unique-
ment deux.

2.2.23 Scalar Fields > Convert to RGB

Assigne à chaque point une couleur à partir des valeurs scalaires courantes et des paramètres d’affichage cou-
rants.

Si l’entité possède déjà des couleurs, il est possible d’écraser la couleur existante ou de mixer les deux valeurs
(CloudCompare pose la question à l’utilisateur si besoin).

2.2.24 Clone

Créé une nouvelle entité 3D identique en tout point à celle sélectionnée (mais indépendante de cette dernière).
Une modification de la liste clonée n’a aucun impact sur la liste d’origine (et inversement).

2.2.25 Fuse

Fusionne deux (ou plus) entités sélectionnées.

Attention : les listes fusionnées sont supprimées à l’issue de cette opération

Toutes les caractéristiques des entités 3D sont conservées. Les listes ne possédant pas initialement telle ou telle
caractéristique la gagneront, avec des éléments par défaut (normale nulle, couleur blanche, etc.).

2.2.26 Translate

Applique une translation à la/les entité(s) sélectionnée(s). L’utilisateur rentre les 3 composantes de la transaltion
(X,Y et Z) via une interface.

2.2.27 Multiply

Multiplie les coordonnées des points de la/les entité(s) sélectionnée(s) par des constantes. L’utilisateur saisit les
3 coefficients multiplicateurs suivant chaque axe (fX ,fY ,fZ) via une boîte de dialogue.
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FIGURE 2.14 – Boîte de dialogue pour la multiplication des coordonnées

FIGURE 2.15 – Interface de paramètrage pour le sous-échantillonnage de nuages

2.2.28 Subsample

Fonction de sous-échantillonnage des points d’un nuage. Différentes méthodes sont actuellement disponibles. Le
choix (ainsi que le paramétrage) se fait via lz boîte de dialogue montrée sur la figure 2.15 :

– Random : sous-échantillonnage aléatoire (les points sont tirés au hasard)
– Space : sous-échantillonnage spatial (la densité locale du nuage résultant est à peu près constante et réglable)
– Octree : sous-échantillonnage rapide via l’octree (on garde un point par cellule de l’octree à un niveau donné

de subdivision)

Remarques :
– Le sous-échantillonnage diffère du ré-échantillonnage (cf. section 2.2.8) dans le sens où il ne crée pas de

nouveaux points mais se contente de sélectionner un sous-ensemble de points à partir du nuage source.
– La méthode de sous-échantillonnage rapide via l’octree (cf. section 2.2.8) choisit le point le plus proche du

centre dans chaque cellule. Ainsi l’écart entre les points est à peu près constant (si le nuage initial est suffi-
samment dense).

2.2.29 Synchronize

Fonction permettant d’aligner deux entités sélectionnées : elle applique simplement une translation pour faire
coïncider les centres de gravité des deux entités.

Remarques :
– Pour appeler cette fonction, il faut sélectionner deux entités, et uniquement deux.
– On retrouve l’interface générique de choix du rôle de chaque entité (section 2.3.4), qui permet à l’utilisateur de

préciser quelle est l’entité qui sera déplacée et quelle est l’entité de référence.

2.3 Menu ’Tools’

2.3.1 Tools > Projection > Unroll

Cette fonction permet de développer sur un plan un nuage de point considéré comme étant porté par une forme
de révolution (cylindre ou un cone). Voir figure 2.17.
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FIGURE 2.16 – Interface de paramètrage pour l’outil de développement d’un nuage

Il faut pour cela renseigner différents paramètres définissant la forme de révolution :
– le type (cylindre ou cone)
– la dimension selon laquelle est positionnée l’axe de développement (X, Y ou Z pour l’instant)
– un point par lequel passe cet axe (dans le cas où la checkbox auto axis est sélectionnée, ce point est automa-

tiquement remplacé par le centre de gravité du nuage)
– le rayon du cylindre ou la base du cone
– et l’angle d’ouverture du cone le cas échéant

Attention, pour optimiser la mémoire, cette fonction applique la transformée directement sur l’entité sélectionnée !
Il peut être nécessaire d’utiliser avant l’outil de clonage - voir section 2.2.24.

FIGURE 2.17 – Exemple de résultat : nuage de points cylindrique (à gauche), et sa développée (à droite)

2.3.2 Tools > Projection > Height Grid Generation

Cette fonction permet de projeter un nuage de point sur une grille régulière suivant l’axe Z.

Une interface (figure 2.18) permet de régler différents paramètres :
– grid step : le pas de la grille exprimé dans l’unité des coordonnées du nuage de points
– type of projection : ce paramètre peut prendre l’une des 2 valeurs suivantes :

– maximum height : soit Eij le sous-ensemble de points du nuage qui est projeté dans la case (i,j) de la grille.
Pour chaque case (i,j) de la grille, on retient comme altitude Z celle du point le plus haut dans Eij .
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FIGURE 2.18 – Interface de paramètrage pour l’outil de projection d’un nuage sur une grille

– average height : pour chaque case (i,j) de la grille, on retient comme altitude Z l’altitude moyenne des points
de Eij .

– fill empty cells with : certaines cases de la grille régulière restent vides après projection (aucun point du nuage
ne s’y projette). Ce paramètre indique avec quelle valeur l’on doit renseigner ces cases et peut prendre l’une
des 3 valeurs suivantes :
– minimum height : les cases vides sont renseignées avec l’altitude Z minimale parmi tous les points du nuage.
– average height : les cases vides sont renseignées avec l’altitude Z moyenne de tous les points du nuage.
– maximum height : les cases vides sont renseignées avec l’altitude Z maximale parmi tous les points du

nuage.

Cette fonction génère deux fichiers (dans le répertoire du binaire de CloudCompare par défaut) :

– height_grid_image.tiff : l’image raster 2D codée sur 256 niveaux de gris correspondant aux altitudes Z des
points projetés dans les cases de la grille ;

– height_grid_text_file.txt : les données de la grille sous un format ASCII (fichier exploitable simplement par un
programme).

Voir figure 2.19 pour exemple de résultat produit par cette fonction.

FIGURE 2.19 – Exemple de résultat : vue 3D à gauche, image 2D des hauteurs à droite
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FIGURE 2.20 – Interface de paramétrage pour l’outil de recalage grossier de deux entités

2.3.3 Tools > Registration > Align

Cette fonction permet de recaler grossièrement deux nuages de points (algorithme "4 points Congruent Sets For
Robust Registration" de Aiger, Mitra et Cohen-Or, Siggraph 2008).

Une première zone de saisie (en haut à gauche) permet d’indiquer les 2 nuages à recaler et leurs rôles respectifs
(Model and Data : le Model est le nuage de référence (qui ne bouge pas) sur lequel viendra s’aligner (si possible)
le nuage Data (qui sera donc déplacé si nécessaire). Comme le recalage calculé est un recalage rigide, seules
des translations et des rotations peuvent être appliquées à l’ensemble du nuage Data. Plusieurs autres paramètres
doivent être renseignés par l’utilisateur pour une utilisation optimale de cette méthode.

Sampling : cette zone concerne l’étape préalable de sous-échantillonnage des nuages de points. Cela permet
d’améliorer sensiblement l’efficacité de l’algorithme. En effet, quelques dizaines de milliers de points suffisent gé-
néralement à obtenir un bon recalage, alors que la complexité de l’algorithme augmente rapidement en fonction du
nombre de points. L’utilisateur devrait toujours chercher à minimiser le nombre de points pris en compte, quitte à
relancer l’algorithme avec plus de points si besoin. Voici les paramètres du sous-échantillonnage :

– Method : méthode de sous-échantillonnage (voir section 2.2.28). Sélectionnez None pour ne pas sous-échantillonner
– Model : un slider et/ou un champ avec variateur permet de choisir le nombre de points conservé pour le nuage

de référence
– Data : idem, un slider et/ou un champ avec variateur permet de choisir le nombre de points conservé pour le

nuage recalé

Registration parameters : cette zone correspond aux paramètres de l’algorithme de recalage en tant que tel. Nous
expliquons en détail ces paramètres :

– Number of trials : l’algorithme procède par essais successifs et ne retient que celui ayant fourni le meilleur
résultat. Ce champ permet de choisir le nombre d’essais à effectuer. Plus la valeur saisie est grande, plus le
calcul sera long, mais plus la probabilité d’obtenir de bons résultats sera élevée. Il peut donc être nécessaire
d’adapter ce paramètre en fonction du nombre de points composant les nuages pour obtenir un bon alignement
dans un temps raisonnable. Pour donner un ordre d’idée, une cinquantaine d’essais pour recaler deux nuages
de 5000 points chacun permet d’obtenir un résultat convenable en quelques minutes (de l’ordre de 2 à 5
minutes, tout dépend de l’ordinateur sur lequel le programme s’exécute).

– Overlap : ce paramètre, compris entre 0.0 et 1.0, correspond à une estimation du taux de recouvrement entre
les deux nuages lorsqu’ils sont correctement alignés. Un taux de recouvrement de 1 signifie que les deux
nuages se recouvrent quasiment entièrement, 0 signifiant que les nuages sont disjoints (dans ce cas, le reca-
lage n’a pas beaucoup de sens). Une estimation très approximative du recouvrement est en général suffisante,
il ne s’agit en aucun cas de renseigner avec précision la valeur effective.

– Delta : ce paramètre correspond à une estimation de la distance moyenne entre les points des deux nuages
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lorsqu’ils sont correctement alignés. Ce paramètre agit comme une tolérance à l’erreur : plus il est proche de
0.0, plus on contraint les nuages à être proches, mais plus la probabilité de trouver une bonne solution est
faible. En principe, si Delta vaut zéro, le programme ne pourra pas trouver d’alignement entre les deux nuages.
En règle générale, pour obtenir de bons résultats, Delta doit correspondre à la résolution (inverse de la densité)
du nuage de référence. L’interface propose un bouton Estimate qui permet d’estimer de manière automatique
ce paramètre en se basant sur un calcul de la densité moyenne du nuage de référence.

– Limit max. number of candidates : lorsque ce champ est activé (pour celà, cocher la case qui y est associé),
il est possible de fixer le nombre maximal de candidats que le programme est autorisé à traiter pour chaque
essai. En effet, lors d’un essai, le processus recherche dans le nuage servant de données des ensembles
de points pouvant mener à un bon recalage. Ces ensembles sont calculés en fonction des paramètres cités
précédemment, et le programmme peut être amené à trouver un nombre énorme de candidats (quelques
centaines de milliers d’ensembles). Ce paramètre permet de ne sélectionner parmi ces candidats que ceux
qui sont considérés comme étant les meilleurs, et donc de raccourcir considérablement le temps de traitement
de chaque essai. En contrepartie, on se prive potentiellement de trouver le meilleur recalage à cause de
l’heuristique utilisée pour retenir les meilleurs candidats. Lorsque ce champ est désactivé, le nombre maximal
de candidats est illimité, ce qui peut conduire à de très grands temps de calcul.

FIGURE 2.21 – Alignement de deux nuages se recouvrant partiellement. A gauche la configuration initiale, à droite le
résultat du recalage avec un recouvrement estimé à 90% (overlap = 0, 9) et une vingtaine d’essais.

Les paramètres Delta et Overlap nécessitent donc que l’utilisateur ait une idée a priori de ce que seront les
nuages après avoir été alignés.

La figure 2.21 présente le résultat obtenu en alignant deux scans d’une peluche relevés sous deux angles sen-
siblement différents. En théorie, la fonction Align est capable de traiter des nuages avec des taux de recouvrement
beaucoup plus faibles que ceux présentés en exemple.

Les alignement calculés via cette fonctionnalité dépendent grandement de la configuration des nuages à traiter.
En effet, leur géométrie ainsi que le degré de ressemblance les rendent plus ou moins facilement comparables. De
ce fait, il se peut que les résultats fournis dans certains cas semblent relativement mauvais. Dans ces situations, vous
pouvez alors utiliser la fonction de recalage fin décrite en section 2.3.4. Il est même conseillé, de manière générale,
d’avoir recours au recalage fin après utilisation de cette fonctionnalité.

Cette fonction crée une copie du nuage Data aligné sur le nuage Model. Il n’est donc pas nécessaire de cloner
les nuages avant, puisqu’ils ne sont pas modifiés directement.

2.3.4 Tools > Registration > Register

Cette fonction permet de recaler deux nuages de points (algorithme "Iterative Closest Point" de Besl et McKay,
IEEE Trans. PAMI 1992).
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FIGURE 2.22 – Interface de paramètrage pour l’outil de recalage de deux entités

Attention : pour que ce recalage fonctionne, il est nécessaire que les deux nuages soit à peu près alignés.

Cette fonction ne permet en aucun cas d’aligner des nuages positionnés et orientés de manière quelconque. Son
rôle est essentiellement d’affiner le recalage des nuages de points dont on estime qu’ils sont grossièrement alignés.
La fonction Align décrite en section 2.3.3 permet de faire en sorte que les nuages soient approximativement alignés
et la fonction Register peut être utilisée sur les deux nuages résultant de cette fonction Align.

La zone supérieure (Model and Data) de la fenêtre de paramètrage permet à l’utilisateur d’attribuer interactive-
ment le rôle de chaque entité. Le Model est le nuage de référence (qui ne bouge pas) et Data désigne le nuage à
recaler (il pourra bouger si nécessaire). Pour aider l’utilisateur, CloudCompare force la coloration des entités et leur
affichage (model en rouge et data en jaune) selon le même principe que l’interface de choix des rôles avant un calcul
de distances (voir paragraphe ci-dessous). Un bouton permet d’intervertir ces roles si besoin (swap).

La partie inférieure (Registration parameters) correspond aux paramètres de l’algorithme de recalage en tant que
tel. Voici leur détail :

– Stop criterion : l’utilisateur choisit soit un nombre d’itérations fixe (ceci permet d’éviter un temps de calcul trop
long, mais ne garantit pas la qualité du recalage) ou au contraire une diminution de l’erreur minimale entre deux
itérations pour justifier d’autres itérations : autrement, l’algorithme s’arrête, estimant que le gain en précision
est insuffisant (ce qui garantit une meilleure qualité mais peut prendre potentiellement beaucoup de temps).

– Enable furthest point removal : heuristique adaptée au recalage d’entités légèrement différentes (puisque
CloudCompare est justement fait pour comparer des nuages potentiellement différents, alors que l’algorithme
est pensé pour recaler des nuages représentant les mêmes objets !). Cet heuristique consiste à écarter les
points trop éloignés à chaque itération du recalage (et ce de plus en plus), pour éviter que les différences entre
les nuages ne fassent trop glisser la position finale du nuage recalé).
Donc cette option ne doit pas être cochée si les deux nuages représentent les mêmes objets.

Choix des rôles (interface générique)

Cette interface générique (figure 2.23) est utilisée par toutes les méthodes de calcul de distance, ainsi qu’un cer-
tain nombre d’autres méthodes (qui l’utilisent comme telle ou sous une forme équivalente). Elle permet à l’utilisateur
d’attribuer interactivement un rôle spécifique à deux entités qui ont été sélectionnées en même temps. CloudCom-
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pare force la coloration des entités en fonction du rôle qui leur a été affecté. Dans le cas des distances par exemple,
le nuage de référence est représenté en jaune et le nuage à comparer (celui qui portera le champ scalaire après
calcul), en rouge. Un bouton swap permet d’intervertir le rôle (et donc la coloration) des deux entités.

FIGURE 2.23 – Interface standard de choix des rôles des entités

2.3.5 Tools > Distances > Cloud/Cloud dist.

Cette fonction permet de calculer les distances (approximatives ou exactes) entre deux nuages de points.

Lors de l’appel de cette fonction, et après avoir choisi le rôle de chaque nuage (Cf. section 2.3.4), un premier
calcul de distances approximatives entre les deux nuages (distances de Chanfrein, calculées via l’octree) est effec-
tué de manière automatique. Cela permet d’afficher dans la partie supérieure de l’interface 2.24 (Approx. results)
diverses informations sur les distances qui peuvent alors être calculées précisément.

Ces informations sont :
– Min. dist. : distance (approximative) minimale
– Max. dist. : distance (approximative) maximale
– Mean. dist. : distance (approximative) moyenne
– Sigma : écart type
– Max relative error : erreur relative maximale de l’approximation (exprimée sous forme d’une fonction de d - la

distance, car cette erreur est dépendante de la distance réelle des points, et généralement décroît rapidement
quand d croît, ce qui veut dire que l’approximation de la distance minimale est généralement très mauvaise,
mais celle de la distance maximale peut-être assez fiable).

L’utilisateur peut enfin afficher l’histogramme des distances approximatives calculées (en appuyant sur l’icone
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FIGURE 2.24 – Interface de paramètrage pour le calcul de distances entre deux nuages de points

), mais celui-ci est généralement assez peu détaillé étant donné le principe du calcul des distances de Chan-
frein via l’octree.

La partie inférieure (Precise results) permet le paramétrage du calcul précis des distances. L’utilisateur peut saisir
les valeurs suivantes :

– Local model : indique quelle une modélisation locale sera appliquée au nuage de référence pour améliorer
la précision du calcul de distance nuage à nuage (dans une certaine mesure). Cette technique permet une
amélioration de la précision globale (et non forcément locale). Cette amélioration dépend du modèle choisi, et
se fait au prix d’un certain ralentissement de la fonction (qui dépend lui aussi du modèle choisi) :
– NONE : pas de modélisation locale (comportement par défaut), on calcule la distance au point le plus proche.
– Least Square Plane : approximation locale du nuage par un plan (ajusté aux moindres carrés) - peu précis

mais rapide.
– 2D 1

2 triangulation : approximation locale du nuage par une triangulation de Delaunay 2D 1
2 (après projection

des points sur un plan ajusté aux moindres carrés) - vitesse et précision intermédiaires.
– Height Function : approximation locale du nuage par une fonction de hauteur du type z = ax + by + cx2 +
dy2+exy (là encore, après projection des points sur un plan ajusté aux moindres carrés) - meilleure précision
mais vitesse réduite.

– Max. dist : permet à l’utilisateur de définir une distance au delà de laquelle il n’est pas nécessaire de calculer
une distance précise. Cela permet d’améliorer fortement les performances du calcul, en particulier sur des
nuages ayant peu de zones communes (en évitant ainsi de calculer des distances éloignées - les plus coû-
teuses - alors que leur connaissance précise est généralement inutile). Les points concernés conservent alors
leur distance approximative. Les informations affichées dans la partie supérieure peuvent grandement aider à
fixer cette valeur limite.

– Octree level : ce paramètre de l’algorithme est normalement adapté au mieux par CloudCompare, mais il est
possible de le forcer au cas où l’heuristique de détermination est défaillante.

Remarques :
– Cette fonction rajoute un champ scalaire C2C Distances au nuage de référence.
– Pour calculer les distance précises il est nécessaire d’appuyer sur le bouton rouge Compute. Autrement, seules

les distances approximatives sont conservées.
– Toutes les distances calculées par cette fonction ou rentrées en paramètre sont exprimées dans la même unité
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que les coordonnées du nuage de points (il n’y a plus d’unité explicite dans CloudCompare 2.1).

2.3.6 Tools > Distances > Cloud/Mesh dist.

FIGURE 2.25 – Exemple de résultat de calcul de distances entre un nuage et un maillage

Cette fonction permet de calculer les distances (approximatives ou exactes) entre un nuage de points et un
maillage.

Cette fonction est largement équivalente au calcul de distances entre nuages (section 2.3.5) mis à part quelques
détails :

– si un seule des deux entités sélectionnées est un maillage, le choix des rôles (section 2.3.4) n’est pas néces-
saire (le maillage est forcément l’entité de référence).

– si les deux entités sélectionnées sont des maillages, les sommets de l’entité comparée seront utilisés en guise
de nuage. Il peut être intéressant d’utiliser la fonction d’échantillonnage de points sur un maillage (Cf. sec-
tion 2.2.10) préalablement, pour avoir une meilleure vision des différences entre maillages (si cela est le résultat
escompté).

– cette fonction rajoute un champ scalaire C2M Distances au nuage de référence (nuage comparé).
– le choix d’une modélisation locale (Local model) n’est pas possible puisque l’entité de référence est ici un

maillage.

2.3.7 Tools > Distances > Closest Point Set

Cette fonction calcule pour chaque point du nuage de référence, le point le plus proche dans le nuage compared.
L’ensemble de ces "points les plus proches" forme un nouveau nuage (Closest Point Set ou CPS).

Remarques
– Pour appeler cette fonction, il faut sélectionner exactement deux nuages de points.
– On retrouve l’interface générique de choix du rôle de chaque liste (Cf. section 2.3.4, qui permet à l’utilisateur

de préciser quel est le nuage d’où sont extraits les points du CPS (nuage compared)et quel est le nuage de
référence.

– Le résultat est un nuage qui a exactement le même nombre de points que le nuage de référence, et dont
chaque point appartient au nuage compared (par définition). Par construction, il peut y avoir des doublons.
C’est un résultat qui est utilisé, par exemple, par l’algorithme de recalage entre deux nuages de points (Cf.
section 2.3.4).
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2.3.8 Tools > Statistics > Compute stat. params

FIGURE 2.26 – Exemple d’estimation automatique des paramètres d’une loi normale pour un champ scalaire

Cette fonction calcule les paramètres de la loi statistique choisie (Gauss ou Weibull) à partir des valeurs du champ
scalaire actif du nuage sélectionné. La fonction renvoie typiquement la moyenne et l’écart-type du champ scalaire
courant si la loi est Normale, ou les paramètres (a, b) si c’est une loi de Weibull (auquel cas CloudCompare affiche
aussi des estimations de la moyenne et de l’écart-type dans la console - voir section 1.1).

La méthode représente graphiquement l’adéquation entre la loi calculée (trait blanc) et l’histogramme du champ
scalaire dans une fenêtre qui apparaît à la fin du calcul (voir figure2.26). Les valeurs des paramètres de la loi sont
affichées en haut de la fenêtre. CloudCompare renvoie enfin, via la console, la distance du χ2 entre la distribution
estimée et les valeurs du champ scalaire.

Remarque : les paramètres de la loi ainsi estimés pourront typiquement être utilisés dans la fonction de test
statistique local (voir section 2.3.9), qui permet de filtrer un nuage de point dont on a calculé les distances par
rapport à un nuage (ou un maillage) de référence.

2.3.9 Tools > Statistics > Statistical test

FIGURE 2.27 – Exemple d’estimation automatique des paramètres d’une loi normale pour un champ scalaire

Cette fonction, centrale dans CloudCompare, permet d’appliquer un test du χ2 local sur un nuage de point muni
d’un champ scalaire. Le test du χ2 est appliqué à chaque point à partir de l’histogramme des valeurs scalaires de
ses n voisins (n étant un des paramètres de l’algorithme). Le test confronte cet histogramme avec une distribution
théorique à deux paramètres (µ et σ dans le cas d’une loi normale par exemple).
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Avant de spécifier les paramètres, l’utilisateur doit choisir le type de distribution théorique (il a le choix actuellement
entre Gauss et Weibull). Le résultat est un nouveau champ scalaire (une valeur pour chaque point - la métrique du
χ2 - qui donne une information sur la concordance locale entre la valeur scalaire et la distribution testée). La théorie
du test du χ2 nous fournit un seuil (calculé à partir de la marge d’erreur p(χ2), dernier paramètre de l’algorithme) qui
permet de classer les points en fonction de leur non-appartenance à la loi testée. Cette loi représentera typiquement
le bruit de mesure, et on obtiendra ainsi l’ensemble des points dont la distance (à l’autre nuage/maillage) ne fait
pas partie du bruit de mesure (par exemple). Ainsi, on aura les points qui ont effectivement subi une modification, un
changement, et on évitera de prendre en compte des points en réalité immobiles mais dont la distance n’est pas nulle
car elle est bruitée. Une fois le nuage séparé en deux classes, on peut garder le groupe des points hors distribution
(voir figure 2.28, en rouge) et les segmenter par exemple en fonction de la proximité relative des points (par une
extraction des composantes connexes - Cf. section 2.3.10).

FIGURE 2.28 – Champ des écarts initial (en haut à gauche), filtrage statistique (en haut à droite), puis extraction des
points hors distribution théorique (en bas à gauche) et enfin extraction des composantes connexes (en bas à droite).

Remarques :
– Pour appeler cette fonction, il faut sélectionner une seule entité 3D, munie d’un champ scalaire actif.
– Pour régler le paramètre p(χ2), il est important de comprendre que le test du χ2 permet uniquement de rejeter

l’hypothèse selon laquelle les valeurs du champ scalaire prises sur le voisinage de chaque point suivent la loi
testée, mais pas l’inverse. Ainsi, plus la marge d’erreur est faible, et plus le seuil du χ2 sera grand (on rejette
moins souvent l’hypothèse citée précédemment, et on classe donc moins de points comme ne suivant pas la
loi testée).

– Inversement, plus p(χ2) est grand, plus on aura de points "hors la loi", colorés en rouge. Notez que ce para-
mètre sert uniquement à pré-positionner les potentiomètres de réglage des couleurs (seuils de coupure et de
saturation des valeurs du champ scalaire) pour l’affichage du résultat à l’écran (Cf. section 1.4.2.2). Ces poten-
tiomètres peuvent être ensuite déplacés par l’utilisateur avant extraction effective des points (par appel de la
fonction Scalar Fields > Filter by Value, qui va créer un nouveau nuage de points ne comportant que les points
présentement affichés à l’écran, c.à.d. les points ne suivant pas la distribution théorique). De plus, la distance
du χ2 est extrêmement divergente et ceci donne une grande marge de manoeuvre à l’algorithme. Ainsi, une
modification relativement grande du seuil de coupure n’aura que peut d’effet sur la classification. Au pire, on
risque de rater un tout petit nombre de points (au niveau des bordures des zones limites).

– Pour obtenir des résultats précis, il faut par contre connaître ou mesurer la distribution du bruit de mesure (une
sorte de bruit moyen, en première approximation, comprenant l’erreur de mesure dûe au capteur, à la surface
scannée, à la lumière, à la température ambiante lors de la mesure, à la création du maillage dans le cas d’une
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comparaison nuage/maillage, etc.). Les paramètres de la distribution statistique correspondante peuvent donc
être définis à partir de connaissances a priori mais peuvent aussi être déterminés à partir d’un champ scalaire
(une portion du nuage typiquement) avec la fonction de calcul de paramètres statistiques à partir d’un champ
scalaire (Cf. section 2.3.8).

– L’algorithme crée un nouveau champ scalaire nomme (Chi2 Distances). Ce champ est ajouté au nuage de
points courant.

2.3.10 Tools > Segmentation > Label Connected Components

FIGURE 2.29 – Interface de paramétrage de la méthode d’extraction des composantes connexes

Cette fonction permet de décomposer un nuage de points en sous-nuages compacts. Si le nuage sélectionné est
composé de plusieurs groupes de points suffisamment dissociés (distants) les uns des autres, il est possible de le
subdiviser assez simplement via l’octree. Ceci est fait dans CloudCompare grâce à une approche d’extraction des
composantes connexes. C’est un algorithme courant, généralement appliqué aux images 2D binaires et qui a été
étendu ici à une grille 3D binaire. Cette fonction produit en sortie une entité par sous-nuage de points (regroupées
dans un nouveau groupe d’entité au niveau de l’arbre de navigation de CloudCompare). La figure 2.28 en bas à
droite est une bonne illustration de son utilité.

L’utilisateur choisit principalement le niveau d’octree auquel l’algorithme sera appliqué (Octree Level). Celui-ci va
en fait définir grossièrement le seuil de distance au-delà duquel les groupes de points (les composantes connexes)
seront considérés comme non connexes. Plus le niveau d’octree est grand, plus le seuil de distance est faible, plus
on extraira de sous-groupes (ce qui n’est pas forcément souhaitable).

Un deuxième paramètre important est le nombre minimal de points par composante connexe (Min. points). Si un
groupe est composé d’un nombre de points inférieur à ce nombre, alors il ne sera pas extrait sous la forme d’une
nouvelle entité. Ceci permet de limiter le nombre de nuages créés par l’algorithme.

Enfin, l’option random colors permet de dire à CloudCompare de générer des couleurs au hasard pour chaque
nouveau nuage.

Remarques :
– Plus le niveau d’octree est grand et plus la mémoire nécessaire (la RAM) est importante. Le niveau d’octree

est donc un paramètre sensible qu’il est difficile de régler a priori, sans expérience. Une approche par niveaux
successifs peut donc être nécessaire (en commençant typiquement au niveau 7). On peut aussi afficher l’octree
(représentation Wire ou Cubes, Cf. section 1.4.6) pour estimer visuellement les tailles des cellules aux différents
niveaux.

– Pour appeler cette fonction, il faut sélectionner une seule entité 3D.

2.3.11 Tools > Segmentation > K-Means

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.

2.3.12 Tools > Segmentation > Front propagation

Cette fonction n’est pas encore intégrée à la version 2.1 de CloudCompare.
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2.4 Menu ’Display’

2.4.1 Display > Full Screen

Cette fonction permet d’afficher la fenêtre principale de CloudCompare en plein écran. Dans ce mode, la totalité
de l’écran est occupé par l’application. La barre de titre de CloudCompare ainsi que la barre de tache de Windows ne
sont plus accessibles, ce qui améliore le confort visuel mais empêche les manipulations habituelles sur les fenêtres
(déplacement, réduction, changement de fenêtre active, ...).

Pour repasser en affichage normal, il suffit de cliquer une nouvelle fois sur la commande Full screen, ou d’utiliser
la touche de raccourci associée (F11).

Note : il est tout de même possible de changer de fenêtre active, même en affichage plein écran, en maintenant
la touche ALT enfoncée, puis en pressant la touche TAB de manière à faire défiler le sélecteur (cf. figure 2.30) jusqu’à
l’application souhaitée. Lorsque la touche ALT est relachée, Windows active la fenêtre de l’application ainsi sélec-
tionnée. Cette commande est utilisable pour toute application.

FIGURE 2.30 – Sélecteur d’application sous Windows

Raccourci clavier : F11

2.4.2 Display > Refresh

La commande Refresh permet d’actualiser l’affichage dans les contextes graphiques.

Raccourci clavier : F5

2.4.3 Display > Test Frame Rate

Cette fonction permet d’estimer le taux de rafraîchissement de l’affichage dans CloudCompare. Cette valeur,
exprimée en images par secondes (FPS : Frame Per Second), correspond à la fréquence à laquelle l’application
actualise l’affichage.

Le test doit durer une dizaine de secondes, et se caractérise par une rotation autour des objets visibles dans
le contexte graphique actif. Une fois le test terminé, le résultat est affiché dans la zone d’information du contexte
graphique.

Note : ce taux dépend directement du nombre de triangles et de points à afficher. Pour des raisons de confort
visuel (cf. section 1.3.4), il est préférable de faire en sorte que le taux de rafraîchissement soit de l’ordre de 25 FPS
ou plus.

Raccourci clavier : F12

2.4.4 Display > Toggle Centered Perspective

Dans le processus d’affichage, la projection définit la manière dont les objets 3D sont dessinés à l’écran de
visualisation 2D. L’affichage de CloudCompare propose deux types de projections :
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– parallèle orthographique : les points sont projetés orthogonalement sur le plan image. Le champ de vision
correspond à un cylindre.

– perspective : les points sont projetés vers un unique point n’appartenant pas au plan image. Le champ de vision
correspond à un cône.

Le plan image peut être assimilé à l’écran de visualisation.

Dans CloudCompare, la commande Toggle Centered Perspective permet de basculer entre l’affichage par pro-
jection orthographique, qui est le mode d’affichage par défaut, et l’affichage par projection perspective. Lorsque cette
commande est activée, le centre de rotation du point de vue est automatiquement placé sur le centre de la scène
observée. Lors des phases interactives (mouvement de souris dans un contexte graphique - cf. section 1.3.3), la
caméra tournera donc autour des objets de la scène.

Si elle est sollicitée une seconde fois, cette commande rétablit l’affichage suivant une projection orthographique.

Raccourci clavier : F3

2.4.5 Display > Toggle Viewer Based Perspective

Cette commande intervient sur l’affichage interactif dans les contextes graphiques en permettant de basculer
entre le point de vue centré sur la caméra et le point de vue centré sur la scène.

Un premier appel à cette commande permet de positionner le centre de rotation du point de vue sur la caméra elle
même. Ce mode est associé à une projection perspective (cf. section 2.4.4). Lors des phases interactives (mouve-
ment de souris dans un contexte graphique - cf. section 1.3.3), la caméra tournera donc sur elle même, en conservant
sa position.

Si elle est sollicitée une seconde fois, cette commande rétablit l’affichage par défaut centré sur la scène et basé
sur la projection orthographique.

Raccourci clavier : F4

2.4.6 Display > Render to File

Effectue une capture d’écran du contexte actif dans un fichier BMP. Cette fonction offre la possibilité d’appliquer
un facteur de zoom au moment de la capture, via la fenêtre présentée en figure 2.31.

FIGURE 2.31 – Fenêtre de zoom pour la capture du contexte graphique courant

2.4.7 Display > Light and Materials > Set Light and Materials

Cette fonction permet de régler les paramètres d’éclairage dans CloudCompare, via l’interface visible en figure
2.32. On y distingue 3 parties :

La premier cadre (Light) est dédié au paramétrage de la source lumineuse. L’utilisateur a la possibilité de définir
une couleur pour chacune des trois composantes de la lumière (ambiante, diffuse et spéculaire) :

– La composante ambiante (Ambient) est la lumière constante, dans laquelle la scène baigne : de nuit par
exemple, la composante ambiante est noire (aucune lumière ambiante).
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FIGURE 2.32 – Interface de paramètrage de l’éclairage

– La composante diffuse (Diffuse) définit la couleur réfléchie par les objets indépendamment de la position de la
caméra.

– Pour finir, la composante spéculaire (Specular ) définit la couleur ré-émise par les objets en direction de la
caméra : plus cette composante est lumineuse, plus les objets semblent brillants (au contraire plus elle est
sombre, plus les objets semblent mats).

Le second cadre (Default materials) permet de paramétrer les couleurs appliquées par défaut aux maillages ou
nuages de points. Dans le cas des maillages, l’utilisateur a la possibilité de définir une couleur indépendante pour
chaque côté de la surface (Mesh front / Mesh back ). Le bouton Points permet de définir la couleur des points dans
les nuages, au même titre que la commande présentée en section 2.2.1.

Le dernier cadre (Others) propose de modifier quelques dernières options d’affichage plus générales. Bakcground
permet de régler la couleur de fond des contextes graphiques. Le fond apparaîtra toujours sous forme d’un dégradé
allant de la couleur paramétrée vers le noir. Bounding-box permet de changer la couleur de la boîte englobante
apparaissant autour des objets sélectionnés. Pour finir, Text permet de paramétrer la couleur du texte affiché dans
les contexte graphiques.

Chacun des boutons décrits précédemment permet de saisir une couleur pour le paramètre qui lui est associé,
via l’interface de sélection des couleurs présentée en section 2.2.1.

Les boutons en bas de la fenêtre permettent d’appliquer les paramètres (Ok et Apply ), de réaffecter les valeurs
par défaut à tous les paramètres (Reset), ou de quitter l’interface sans prendre en compte les modifications (Cancel).

2.4.8 Display > Light and Materials > Toggle sun light

Permet d’activer ou désactiver la source lumineuse principale. Il est nécessaire qu’au moins une source lumi-
neuse soit active pour que les effets d’éclairage soient visibles (ombrage, couleur, ...).

Raccourci clavier : F6

2.4.9 Display > Light and Materials > Toggle custom light

Permet d’activer ou désactiver la source lumineuse personnalisée.

Cette source lumineuse est, contrairement à la source principale ("sun light" - Cf. section 2.4.8), une source ponc-
tuelle. Elle apparaît d’ailleurs sous forme d’une petite étoile jaune autour de l’objet (voir remarques ci-dessous). Elle
a par contre les mêmes caractéristiques que la source principale.
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FIGURE 2.33 – Source lumineuse secondaire (custom light)

Il est possible de la déplacer en maintenant enfoncé la touche CTRL tout en faisant un "PAN" avec la souris
(bouton droit enfoncé).

Remarques :
– Raccourci clavier : F7
– L’étoile n’apparait qu’avec la projection orthographique (voir section 2.4.4 ou 2.4.5).
– L’étoile peut être parfois positionnée initialement à l’intérieur de l’objet !

2.4.10 Display > Console

Cette commande permet d’afficher ou de masquer la console visible par défaut dans la partie inférieure de la
fenêtre principale de CloudCompare (cf. section 1.1).

2.5 Menu ’Plugins’

Les plugins sont des extensions proposant des fonctionnalités avancées, mais qui ne sont pas intégrées direc-
tement dans le noyau de CloudCompare. Ils correspondent à des fichiers ".dll" (sous un OS windows) qui sont des
librairies dynamiques.) L’application peut parfaitement fonctionner sans ces fonctions, dont le domaine d’application
sera typiquement eloigné du coeur de métier de CloudCompare.

À son lancement, CloudCompare recherche les plugins disponibles dans un certain nombre de répertoires pré-
définis, et seuls les fichiers .dll (sous Windows) trouvés sont chargés et rendus disponibles dans l’interface de l’ap-
plication. Ce manuel présente les plugins disponibles avec la version officielle de CloudCompare.

Il est toutefois possible donc que, pour une raison ou une autre, vous ne possédiez pas ces plugins dans votre
installation, ce qui encore une fois n’entrave en rien le bon fonctionnement de CloudCompare.

2.5.1 Plugins > PCV

Cet outil permet de calculer rapidement l’illumination des points d’un nuage ou des sommets d’un maillage par
détermination de la "Portion de Ciel Visible" (P.C.V. - voir figure 2.36).

Cet éclairage consiste à calculer pour chaque point la quantité de ciel qu’il voit, ou autrement dit la quantité d’éner-
gie lumineuse qu’il recevrait si le nuage était éclairé uniformément. Ceci permet de colorier les points en fonction de
leur profondeur relative et fait très bien ressortir le relief et la micro-géométrie. En pratique le calcul est effectué avec
un algorithme équivalent à ShadeVis (proposé initialement par Cignoni et al. du VCG).
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FIGURE 2.34 – Rendu classique avec normales (gauche) et rendu "PCV" (droite)

Les deux principaux paramètres de l’algorithme, modifiables via la boîte de dialogue associée à la fonction (figure
2.35), sont :

– le nombre de « rayons » lumineux. Pour chaque direction d’éclairement (rayon), l’algorithme projette, via la carte
graphique, les entités selon cette direction et calcule la visibilité des points (ou des sommets d’un maillage).
Cette information est accumulée pour chaque direction et permet de calculer l’éclairement global. Plus le
nombre de rayons est grand, et plus la dynamique est importante et les différences d’éclairement entre deux
points fines. Par contre, le temps de calcul est proportionnel au nombre de rayon.

– la résolution du buffer de rendu. La projection des entités selon une direction se fait dans un buffer vidéo dont
la résolution va jouer sur le pouvoir de séparation entre points. Plus la résolution est forte, et mieux les points
seront dissociés (d’où un meilleur calcul de leur éclairement propre et une meilleure finesse du résultat). Par
contre, si la résolution est trop grande, outre un temps de calcul et une consommation mémoire plus importants
(cela dépend des performances de la carte graphique), il faut aussi se méfier du fait que le nuage peut devenir
"poreu" et laisser passer la lumière (voir remarque ci-dessous). Dans le cas d’un maillage ceci ne pose pas
problème. Les cartes graphiques actuelles assurent des performances très intéressantes dans l’absolu, il ne
faut donc pas hésiter à utiliser des valeurs importantes pour ces paramètres (telles que les valeurs par défaut).

Remarques :
– L’algorithme crée un nouveau type de champ scalaire (« PCV ») et la rampe de couleur « Gray » (niveaux de

gris) est automatiquement activée.
– La lumière simulée par l’algorithme PCV est considérée comme provenant de l’hémisphère des Z positifs. Z

correspondant à la direction verticale, le nuage de points doit donc être orienté en conséquence avant tout
calcul.. Si la checkbox "360˚ mode" est cochée, la lumière vient du globe complet et la direction ne joue plus.

– Puisque l’illumination calculée par cet algorithme est un champ scalaire, il est possible de jouer avec les poten-
tiomètres de saturation pour régler le contraste. Dans le cas d’un maillage, on peut aussi utiliser les fonctions
de moyenne et de rehaussement du contraste (voir sections 2.2.12 et 2.2.13). Une fois les paramètres correc-
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FIGURE 2.35 – Interface de paramétrage de PCV

tement réglés, on peut transformer le champ scalaire en couleurs avec la fonction « Scalar Fields > Convert to
RGB » (section 2.2.23).

– L’éclairage provenant du ciel est représenté de manière discrète par un nombre limité de « rayons » lumi-
neux, qui sont échantillonnés de manière uniforme sur l’hémisphère (ou la sphère complète si le mode 360˚
est activé). Il n’y a pas pour autant de lancer de rayons dans ShadeVis (on devrait plutôt parler de direction
d’observation - Cf. l’article de Cignoni et al. pour plus d’informations).

– Dans le cas des maillages, il est possible d’accélérer l’algorithme si le maillage est fermé (option « closed
mesh », activée par défaut).

– Dans le cas des nuages de points, il faut faire attention à ce que la résolution ne soit pas trop grande, sinon
des « trous » peuvent apparaître entre les points lors du rendu interne : cceci est simplement dû au fait que la
densité d’un nuage est limitée, et que pour un niveau de zoom suffisant, on observera toujours des zones sans
information entre les points.

2.5.2 Plugins > HPR

La fonction Hidden Points Removal tente, comme son nom l’indique, de filtrer le nuage de points sélectionné de
sorte à ne conserver que les points visibles (correspondant à la surface implicite effectivement visible depuis le point
de vue courant). Les points considérés comme étant masqués sont alors cachés. Le résultat dépend donc fortement
du point de vue.

La notion de visibilité pour les points d’un nuage est relativement complexe à estimer. En effet il est très peu
probable qu’un point soit réellement masqué par d’autres points dans un nuage, puisque celà nécessiterait un ali-
gnement parfait entre paires de points ou une densité du nuage telle que les points soient quasiment en contact.
Cette fonction approxime donc la notion de visibilité via un calcul d’enveloppe convexe. Elle se base sur l’article
Direct Visibility of Point Sets de Katz, Tal et Basri, SIGGRAPH 2007.

Pour calculer les occlusions par HPR, il est nécessaire que le contexte graphique du nuage soit en projection
perspective (cf. section 2.4.4). Si ce n’est pas le cas, un message d’erreur prévient l’utilisateur lui demandant d’acti-
ver la projection perspective. L’utilisateur doit ensuite choisir le niveau d’octree utilisé par la fonction (figure 2.37). Le
niveau d’octree permet d’accélerer le calcul de l’enveloppe convexe (structure assez lourde) en réduisant le nombre
de points utilisés (par sous-échantillonnage). Plus le niveau est élevé, et plus le calcul d’occlusion sera fin, mais plus
le traitement sera long.

Une fois le filtrage effectué, celui-ci n’est valide que pour la position de caméra courante (et des positions très
proches dans une certaine mensure). Il faut relancer l’outil pour mettre à jour le filtrage selon tout nouveau point de
vue.

Attention, les points cachés par cette méthodes ne peuvent pas être ré-affichés via une méthode ad-hoc (pour
l’instant). Il faut en attendant utiliser un artifice : activer l’outil de segmentation manuelle sur le nuage (l’icône des
"ciseaux" - section 1.5.1) qui réinitialise l’information de visibilité par point) puis quitter ce mode.
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FIGURE 2.36 – Nuage de point complet (en haut) et nuage de point filtré avec la technique "HPR" (en bas)

FIGURE 2.37 – Interface de choix de niveau d’octree

2.6 Menu ’3D Views’

2.6.1 3D Views > New

Permet d’ouvrir un nouveau contexte (fenêtre) graphique.

Remarques :
– Raccourci clavier : CTRL + F3
– Le nouveau contexte graphique est nommé en fonction du nombre de contextes ouverts depuis le lancement

de CloudCompare. Si n contextes graphiques ont été ouverts durant la session, quelque soit le nombre de
contextes restant, l’élement créé sera automatiquement nommé "3D View n+ 1".

– Les contextes ainsi créés sont vierges : ils ne contiennent aucun objet, et il appartient à l’utilisateur de répartir



52 CHAPITRE 2. FONCTIONS

l’affichage des entités disponibles comme il le souhaite (cf. section 1.3.2)

2.6.2 3D Views > Close

Ferme le contexte (fenêtre) graphique actif.

Remarques :
– Raccourci clavier : CTRL + F4
– Les objets rattachés au contexte graphique ainsi supprimés ne sont réaffecté à aucun autre contexte, et ne

sont donc plus visualisables. L’utilisateur pourra s’il le souhaite répartir l’affichage des objets dans les contextes
graphiques restants (cf. section 1.3.2).

2.6.3 3D Views > Close all

Ferme tous les contextes (fenêtres) graphiques.

2.6.4 3D Views > Tile

Cette commande permet de partionner l’espace d’affichage entre les différents contextes graphiques ouverts.
Les contextes sont disposés de manière à ce que l’espace d’affichage soit entièrement rempli, et qu’il n’y ait aucun
chevauchement entre contextes (ils forment une mosaïque).

Note : Cette organisation est utile pour visualiser tous les contextes simultanément.

2.6.5 3D Views > Cascade

Permet d’organiser les contextes graphiques en cascade : les contextes sont superposés dans l’ordre suivant
lequel ils ont été créés.

Note : l’organisation en cascade est utile lorsqu’il s’agit de naviguer rapidement entre les contextes existants.

2.6.6 3D Views > Next

Cette commande permet de passer au contexte graphique précédent (activation du contexte précédent à la place
du contexte actuel).

Note : L’ordre des contextes graphiques repose sur leur nom, et donc sur leur ordre de création. Le contexte
"précédent" correspond donc au dernier contexte encore ouvert crée avant le contexte actuel.

2.6.7 3D Views > Previous

Cette commande permet de passer au contexte graphique suivant (activation du contexte suivant à la place du
contexte actuel).

Note : Le contexte "suivant" correspond au premier contexte encore ouvert créé après le contexte actuel.

2.7 Menu ’Help’

2.7.1 Help > Help

Affiche la documentation utilisateur de CloudCompare.
Raccourci clavier : F1.

2.7.2 Help > About

Affiche la fenêtre d’information de la version courante de CloudCompare (cf. figure 2.38).
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FIGURE 2.38 – Fenêtre d’informations

2.7.3 Help > About plugins

Affiche la fenêtre d’information des plugins (figure 2.39). Cette fenêtre affiche sous forme d’arborescence déve-
loppable les plugins disponibles. Les répertoires dans lesquels CloudCompare cherche les plugins sont affichés en
haut de la fenêtre.

FIGURE 2.39 – Fenêtre d’information des plugins
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Annexe A

Annexes

A.1 Formats de fichiers

A.1.1 Fichiers de primitives 2D/3D reconnus

Extension Type P M RGB NG N S Autre Description
asc, txt,
neu, xyz,
etc.

ascii " " " " "
nuage de points
ASCII

bin binaire " " " "

nuage(s) de
points, format
binaire
spécifique à
CloudCompare

ply ascii /
binaire " " " " " " "

maillage
(Stanford)

obj ascii " " "
maillage
(Wavefront)

soi ascii " "
nuage(s) (Soisic,
Mensi)

(c)bin binaire " "
nuage (C.
Hernandez)

pn binaire " "
nuage (point +
normale)

pv, pcv binaire " "
nuage (point +
valeur)

icm ascii "
association
nuages/images

P : Points
M : Maillages
RGB : Couleurs (Red, Green, Blue)
NG : Niveaux de Gris
N : Normales
S : Scalaires
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A.1.2 Chargement et sauvegarde

Chargement Sauvegarde
asc, txt, neu, xyz,
etc. " "

bin " "

ply " "

obj " "

soi "

(c)bin "

pn " "

pv, pcv "

icm "

A.1.3 Formats spéciaux

A.1.3.1 Fichier ICM

Fichier d’association entre un nuage de points et un fichier VRML de définition des photos calibrées (caméra +
fichier image).

Exemple :
fichier «toto.icm »

#CC_ICM_FILE //header
FILENAME=pa4.asc //Fichier de points
FILETYPE=ASC //Type du fichier de points
IMAGES_DESCRIPTOR=photo_match.wrl //Fichier VRML de description des photos

calibrées
fichier «photos_match.wrl »

#VRML v2.0 utf8

DEF photo1.jpg Viewpoint{ //Header photo #1
fieldOfView 0.621379 //F.O.V.
position -10.5418 -15.6091 5.95961 //Centre optique
description «VANNE + PETIT TUYEAU » //Description
orientation 0.70724 -0.37292 -0.600618
3.74252

//Vecteur «visée »

} //Fin de photo #1

DEF photo2.jpg Viewpoint{ //Header photo #2
fieldOfView 0.621379 //etc.
position -3.9782 -21.276 5.95616
description «PORTE »
orientation 0.572629 0.696275 -0.432778
2.02135
}

Un tel fichier VRML peut être généré quasi-automatiquement par un logiciel comme RealWorks (Mensi).

A.1.3.2 Fichier d’export de carte de profondeur

Fichier ASCII d’export de carte de profondeur associée à un capteur. Peut être généré via la fonction Sensor >
Ground-Based Lidar > Export depth buffer (section 2.2.15).
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Exemple :
fichier «Ground Based Laser Scanner.txt »

// CLOUDCOMPARE DEPTH MAP
// Associated cloud : Cloud #0 associated cloud name (as disp. in CC)
// dPhi = 0.005000 [ -0.383052 : 0.319331 ] horizontal angular step
// dTheta = 0.005000 [ -1.626588 : 0.137948 ] vertical angular step
// pMax = 78823.398438 max depth
// L = 353 number of horiz. pixels
// H = 141 number of vert. pixels
/////////////////////////
0.000000 0.000000 18132.496094 1st pixel coordinates (i,j) and depth (z)
1.000000 0.000000 15145.963154 2nd pixel coordinates (i,j) and depth (z)
...
352.000000 140.000000 132135.321542 L*H pixel coordinates (i,j) and depth (z)
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